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Welcome to WinSCAN 3.0 CS 
The Single-Switch Control Interface 

for PCs with Windows 

WinSCAN provides single-switch users independent control access to educational and 
productivity software, multimedia programs, and recreational activities that run under Windows 
8.1 and Windows 10 on compatible personal computers. WinSCAN creates a scanning display 
containing words or pictures to represent functions you need to navigate Windows and to operate 
specific software. The display window can scan vertically, horizontally, or by row or column. It 
can be repositioned on the PC display screen. You can create custom setups for specific 
programs, print them, save them for reuse or further editing, link them together, or use them to 
start your PC automatically with WinSCAN up and running. 

 

 

 

WinSCAN works with a single-switch USB control interface adapter produced by 
Academic Software, Inc (ASI) called SS-ACCESS USB Adapter. One end of this 
adapter plugs into a USB port on the PC or on a hub connected to the PC. Almost 
any type of external adaptive switch can plug into a standard phone jack at the other 
end of the adapter. When the WinSCAN software is running, it moves a scanning 
selector and refreshes the display in real time while monitoring the state of the 
external switch. When you respond to the scan by pressing the switch, WinSCAN 
sends the appropriate mouse function, keystroke, or key command to the running 
application program. You can open folders, select icons, run applications, switch to 
new setups, point and click, cut and paste, drag and resize, use function keys and 
combination key commands, enter text, read e-books and email, surf the Internet, 
and more with WinSCAN and your single-switch! 
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When navigating Windows, 
look out for rocks and shoals! 

 

With WinSCAN and your single-switch, you can accomplish almost everything that can be 
done with the mouse and the keyboard ... BUT ... the keyword here is almost. There are some 
things that you can't do at all with WinSCAN. There are other things that you can do, but that 
will cause grief – meaning that the scanning display may pause or become hidden in such a way 
that single-switch control is lost and regular mouse or keyboard input is required. For single-
switch users, this may necessitate restarting the computer. Most of these potential trouble spots 
are rare situations and are documented at various points in this User's Guide. However, a few 
things you should know about and avoid right from the beginning: 

• Occasionally the Windows operating system suspends all running software to await a user 
response, such as clicking an OK button (usually due to a system error). This effectively 
stops WinSCAN and the single-switch user as well.1 

• When the WinSCAN scanning display window has the focus (is highlighted), the 
ESCAPE key - on the keyboard or in the scanning display - closes the scan window and 
brings back WinSCAN's main Setup Window. This also stops the scan and the user. 

• WinSCAN requires the Windows mouse driver to provide mouse functions. Without a 
mouse attached to the computer, Windows may not load the mouse driver software and 
WinSCAN's mouse functions are inoperative. Mouse function scan keys won't work in this 
situation but scanning displays containing other keyboard or special functions will operate 
normally. (This is seldom a problem, especially on laptop PCs.) 

Barring the above problematic situations, you should have little or no difficulty installing and 
running WinSCAN on your computer. This User's Guide is designed to help. The guide is 
divided into several chapters. The first two chapters take you through the software installation 
process and the "quick start." Whether you are an expert or a beginning PC user, these sections 
demonstrate how WinSCAN works and what it does. 

  

                                                
1  Should WinSCAN ever appear to completely stop or "hang" in some way, a last resort before re-starting your 

computer is the Windows Task Manager, accessible by right-clicking on the START button. The Task manager 
allows the user to close an application which is experiencing problems. 
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The next three chapters provide a series of step-by-step tutorials. Completing these exercises will 
help you learn how to design and use custom scanning displays for general purposes or particular 
applications. A command and function reference chapter follows the tutorials to provide detailed 
information about each menu option and program function. A chart of useful shortcuts is also 
included. 

As an operating system for your PC, Windows provides a rich and powerful graphic environment 
for managing files, running programs, and controlling devices such as printers. Typically, there 
are multiple ways of accomplishing most tasks. A good understanding of this operating system 
will help you create efficient WinSCAN scanning displays. The final chapter of this guide is a 
technical discussion and reference covering a range of topics and situations related to the 
interaction among Windows, WinSCAN, other application programs, and peripheral devices. 

At Academic Software, Inc., we believe you will be pleased with WinSCAN. We want to hear 
from users about features you would like to see in future versions. We want to hear about success 
stories and about any problem you may have encountered. Be sure to return your WinSCAN 
registration card promptly and feel free to email asistaff@acsw.com or call for technical support 
or product information, Monday-Friday, 9am-5pm EST, at 1-859-552-1020. 

 

 

 

 

 

  

Enjoy 
WinSCAN! 
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Visit ASI on the Internet at http://www.acsw.com 

For further product information, we encourage you to visit our company's web site on the 
Internet or to send us e-mail to asistaff@acsw.com. Our site features a FREE DOWNLOAD 
PAGE where we provide a WinSCAN Setup File Library with custom setups for particular 
games, multimedia programs, CD-ROM's, and educational software. These are setups that we 
design or that WinSCAN users provide for us to share with others. If you have created a 
particularly good WinSCAN setup for a program you use, attach the file to an e-mail to us with a 
brief explanation and we will post it on the Web. 

What's New with WinSCAN 3.0 CS2 

Previous users will recognize that WinSCAN 3.0 retains the simplicity and ease of use that 
marked earlier versions, while at the same time offering a host of powerful new features that 
greatly enhance its utility as a complete access tool for single-switch users. Among the most 
important features are: 

• 90 built-in icons to represent scan functions which now can be displayed in three sizes 
(small, normal, and large)  

• Up to 20 scan positions in the main scanning display 

• User-defined # of rows and columns in the display (e.g., 1x10, 4x5, 7x2, etc.) 

• Rapid and simplified WinSCAN custom setup design features. 

• Choice of linear (horizontal or vertical), row/column, or column/row scanning 

• Choice of audible tone modes (none, at each icon as scan progresses, or in response to each 
switch activation 

• A variable-length "dwell" or "activation delay" function to give the user time to attend the 
screen to see the consequences of input 

• Two different DRAG modes to meet most normal dragging requirements 

• Precision controls for mouse cursor positioning and dragging operations 

• "Text Plus" and "Text Only" special functions provide extensive keyboard and mouse 
emulations when needed. 

• A "Control Panel" special function allowing the single-switch user to adjust scan speed, drag 
mode, and many other settings independently 

• A powerful capability to create and link associated setups for multiple programs and to 
switch between these setups independently 

• Plus many other small improvements that all WinSCAN users will appreciate 
  

                                                
2  CS stands for C#, the programming language for WinSCAN. 
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The WinSCAN package: 

 

• SS-ACCESS USB Adapter single-switch interface 
• WinSCAN Software 8gb distribution flashdrive 
• WinSCAN Quick Start and Registration cards 
If you are missing any of the above items, contact 
Academic Software, Inc., at asistaff@acsw.com or 1-859-
552-1020 for replacements. 

System Requirements: To run WinSCAN, you need: 
• A PC using Microsoft Windows OS 8.1 or higher 

(WinSCAN requires the .Net 4.5.1 Framework. 
Windows, since version 7, comes equipped with .Net 
and will update that as needed automatically over the 
Internet. Thus for installation, an Internet connection 
may be required.) 

• An unused USB port for the SS-ACCESS USB Adapter 
interface for your switch  

Installation Information: 

 

 

Your WinSCAN flashdrive (named ASI_FLASH1) con-
tains five directories. These include: 
WS Publish: contains all the files needed to install 

WinSCAN automatically as a ClickOnce application on 
your hard disk. 

WS Release: contains files for manual copying and stand-
alone use, without using the Installer. All files in this 
directory are necessary and must be kept together. 

WinSCAN Setups: contains several useful WinSCAN 
setup file examples, including General.ws and 
Solitare.ws 

SS-Demo Publish: contains all the files needed to install 
SS-Demo (a fun, free single-switch program example) 
automatically as a ClickOnce application on your hard 
disk. 

SS-Demo Release:  contains files for manual copying and 
stand-alone use, without using the Installer. All files in 
this directory are necessary and must be kept together. 

There may also be a file named WinSCAN Users 
Guide.pdf (this User's Guide) and a file named readme.txt 
containing useful notes and information not available when 
this User's Guide was written. 
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To install WinSCAN using the ClickOnce Installer program: A ClickOnce setup.exe Installer 
is a special program provided by Microsoft to install ClickOnce application programs "safely" on 
Windows computers. In addition, the Installer places an "application reference" shortcut icon 
(that points to the WinSCAN CS.exe program wherever that is installed) in the Windows 
START SCREEN APPS list and on the user's Desktop. Further, it facilitates completely 
removing the program using the Windows Add/Remove Programs tool. Finally the Installer 
program will set a default filetype (.ws for WinSCAN setup files) that will be opened by the 
application program being installed. 

To install WinSCAN on your computer, 
open the WS Publish directory and 
double-click on the setup.exe file. This 
will evoke the Application Install window 
shown here. ClickOnce applications are 
"signed" and certified programs. They can 
use an official registered "certificate" from 
a certification guarantor or they can use a 
company-signed certificate. In the former 
case, the Publisher field identifies the 
company that paid the certification 
guarantor for that service. In the latter 
case, the Publisher field is "Unknown 
Publisher." Academic Software, Inc. uses a company-signed certificate. If you trust that your 
software came from ASI or its distributors, then click Install to proceed and follow any further 
prompts. Otherwise, you can not use the ClickOnce Installer. 

To copy and/or run WinSCAN manually as an ordinary executable Windows program: If 
you choose not to use the Installer, copy the entire WS Release directory (with all of its files) 
from your flashdrive to your Desktop or to your hard drive (e.g., into a c:\ASI directory that you 
create for ASI software). It would be a good idea at this time to right-click on the WinSCAN 
CS.exe file in the WS Release folder you copied and select the Create shortcut option. Then 
move the resulting shortcut icon to your Desktop. You can run WinSCAN by clicking on this 
shortcut icon or by opening the c:\ASI\WS Release directory folder and double-clicking directly 
on the WinSCAN CS.exe program file. (You can also run WinSCAN the same way directly 
from your WinSCAN Software flashdrive itself.) 

To copy the setup file examples to a location on your hard disk: The WinSCAN Setup 
directory on your flashdrive contains a number of example setups (including General.ws and 
Solitaire.ws) to which we will be referring frequently throughout this User's Guide. We 
recommend that you create a directory folder on your hard drive named c:\WinSCAN and copy 
all of these example setup files into that folder. We also suggest saving setup files that you create 
in this location. 
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To copy and print this User's Guide: This User's Guide is distributed on the WinSCAN 
Software flashdrive as a PDF file. It is also a part of the WinSCAN program files and can be 
called up from within WinSCAN through the Help menu or by using the Ctrl-H command key 
sequence when the WinSCAN Setup Window is displayed. As a PDF file, the free and widely 
available Adobe Acrobat Reader or some other similar PDF file reader program is required as a 
default program to open PDF files such as WinSCAN Users Guide.pdf. If need be, we suggest 
that you visit the Adobe website at https://get.adobe.com/reader and download this free program. 
Adobe Acrobat Reader provides many options for reading and printing PDF files, including 
double-sided booklet formats. (This User's Guide is also available in bound book and e-book 
formats from ASI for assistive technology centers, schools, professionals, and other users.) 

What is the SS-Demo Program? A demonstration program is provided for you to test the use of 
your switch with WinSCAN, either by using the SS-Demo.ws setup provided on the WinSCAN 
Software flashdrive or by defining a single scan key WinSCAN setup using either the ENTER 
key function or the Alt+S combination key function. 

The SS-Demo ClickOnce 
Installer installs this program 
and adds an icon for it to the 
Windows START SCREEN APPS page 
and to the Desktop. After reading the next 
two chapters, run this demo by double-
clicking its Desktop icon. A scene will 
appear and music plays. Along comes a 
character. Press your switch to stop the 
character. Another press of the switch will 
paste the original character in place and 
begin moving a copy of that character to 
the left. Continue pressing the switch to 
paste and move as many characters as you 
wish!3 Use SS-Demo.ws scanning display 

mouse functions or command scan keys (or the regular keyboard) to enter other commands: e.g., 
press Alt+A to view the program credits or Alt+Q to quit. 

 

 

This completes your software installation.4 

  
                                                
3 After 20 characters are added, the display starts over. The window can be resized. Press ALT to reveal the underlined 

hotkeys. SS-Demo should work with most other single-switch interfaces as well, including single-function switch 
interfaces such as SS-ACCESS for Windows, also available from Academic Software, Inc. 

4  Further information about installation is provided in the Technical Information chapter of this User's Guide. 
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Getting Started Quickly 
This section demonstrates one way to get started quickly with WinSCAN. You will learn how to 
start the setup program, open a previously prepared scanning display setup, run the program, and 
use WinSCAN to navigate Windows. Following sections introduce many other features and 
controls for WinSCAN in step-by-step fashion. There you explore the menu options for creating, 
printing, saving, loading, and customizing your own WinSCAN scanning displays for later use 
with Windows application programs. 

This is the WinSCAN program icon. The ClickOnce Installer placed the WinSCAN 
CS.exe program and support files in a special location on your hard drive.5 It also 
placed shortcut icons in the Windows START SCREEN APPS list and on your 
Desktop. The Installer also establishes the WinSCAN program as the default 
program to open WinSCAN setup files which use the filetype suffix .ws.6 We 

recommend that you create a new folder named c:\WinSCAN on your c: drive and use that to 
store all WinSCAN setups that you create or download or that are provided in the WinSCAN 
Setups folder on your WinSCAN Software flashdrive. 

Step 1: Insure that the SS-ACCESS USB Adapter single-switch interface is plugged into one of 
your PC's USB ports and that an adaptive switch is plugged into the phone jack on the 
other end of the adapter. 

Step 2: Using the mouse, click on the WinSCAN icon to select it and press ENTER on the 
keyboard to run the program. 

Of course, you also could double-click the icon to run the program, but the basic strategy of (1) 
positioning the mouse, (2) clicking to select an object or menu item, and (3) using the ENTER key 
to perform the object's function is an efficient way to use the WinSCAN scanning interface to 
navigate Windows and operate programs and games. 

  

                                                
5  A ClickOnce program is a "safe" and self-contained type of program which will not interfere with other programs on 

your computer. Windows does not install this type of program in the ordinary c:\programs folder. More information 
is provided in the Technical Information chapter later in the User's Guide, including easy uninstall directions. 

6  Should this filetype association not be set up on installation, further instructions are provided in the Technical 
Information chapter. 
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When WinSCAN starts, it displays the main WinSCAN-Untitled 
setup window as shown above. This is a standard window that 
can be resized, repositioned, minimized, covered, or closed like 
any other application program window. WinSCAN will 
remember where it was positioned on the Desktop when it was 
last closed and will open there the next time it runs. 

Step 3: Using the mouse or the Alt+F command key 
combination, pull down the WinSCAN File menu. 

Step 4: Choose the Open option from the File menu by clicking 
on it or pressing the O key. (Ctrl+O opens the Windows 
File Open dialog box immediately when WinSCAN has 
the focus – e.g., when the title bar of the window is 
highlighted.) 
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WinSCAN is shipped with several standard setup files for general access and for popular 
programs and games. You can create and save easily new setups for particular purposes. A 
WinSCAN setup filename ends in the filetype suffix .ws. By default, the File Open dialog box 
shown above always displays only those files in the current directory ending in this suffix. The 
General.ws setup shipped with all versions of WinSCAN is designed for general purpose 
Windows access, navigation, and program control. We recommend that you create a new folder 
named c:\WinSCAN on your c: drive and use that to store all WinSCAN setups that you create 
or download or that are provided in the WinSCAN Setups folder on your WinSCAN Software 
flashdrive. Here we assume you have done that. Use the hierarchical folder and file directory list 
to the left of the OPEN a WinSCAN Setup File dialog box to locate your setup file folder and to 
display the files inside it. 

Step 5: Using the mouse or the TAB, ARROW, and ENTER keys, choose the file named 
General.ws or type the word general in the File Name field. 

Step 6: Click the Open button or select this control with the TAB key and press ENTER to 
open this WinSCAN setup and return to the main setup window. 
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The WinSCAN-General.ws setup window shown above now 
displays all information about the General.ws setup. Notice 20 
scan positions are available and 16 are defined in the Position 
Information table (scroll down to see all of these or enlarge the 
main window); SS-ACCESS shows it is on-line, the scan speed 
is .75 second; etc. 
Step 7: Press the external switch to test switch action. The 

Welcome icon to the lower left of the window should 
change each time the switch is activated. 

Step 8: Again using the mouse or Alt+F command key 
combination, pull down the WinSCAN File menu. 

Step 9: Choose the Run option from the File menu by 
clicking on it or pressing the R key. (Ctrl+R runs the 
current WinSCAN setup immediately.) 
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When you select Run or press Ctrl+R, the main setup window disappears and the current 
WinSCAN scanning display window - e.g., for the General.ws setup that was just opened - 
appears centered at the bottom of the screen. The scan should be running in row-column mode at 
the rate of one step each three-quarters of a second. The mouse cursor has been centered on the 
screen. Your computer display may look similar to the example shown above. 

You are now up and running with WinSCAN! From this point, a single-switch user has almost 
complete control over the computer. For example, wait until the scanning selector reaches the 
third scan key icon representing Mouse Up. Press and hold down the external adaptive switch. 
The mouse cursor should begin to move steadily up in incremental steps of 15 pixels. Release the 
external switch. The cursor should stop moving. The scanning selector returns to the upper left 
scan key and resumes scanning. Use the Control Panel scan key to adjust WinSCAN settings on-
the-fly or to switch to an associated setup (e.g., solitare.ws). Use the Text Plus scan key to 
access a full scanning keyboard display. 

Move the mouse cursor over a folder icon or a Windows program icon on the desktop. Wait until 
the scanning selector reaches the top row. Press and release the external switch. The scan 
selector will begin to move across that row. Wait until the Mouse Click scan key (in the fifth 
position on the top row) becomes selected. Press and release the external switch. The folder or 
program icon should change color indicating that it has been clicked on by the mouse. The 
scanning selector returns to the top row. Press and release the external switch again. Now wait 
until the scanning selector reaches the Enter scan key. Press and release the external switch. If 
the icon represents a folder, it should open on the desktop within a Windows File Explorer 
window. If the icon represents a program, then that program should load and run as though it had 
been started by the mouse. 
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Important! How to quit. 

To quit WinSCAN, make the scanning display window active (by clicking on it with the mouse 
to give it the focus) if it is not active already. Then press the ESCAPE key on the keyboard. The 
scanning display will vanish and the main WinSCAN setup window will reappear. At this point, 
to quit WinSCAN fully, you may: 

(1) double-click the System Menu box (the small WinSCAN icon) at the left in the main 
window title bar or 

(2) double-click the Close icon at the right of title bar or 

(3) press the Ctrl+Q command key combination or 

(4) select the Quit option from the File menu 

 

 

 

 

 

  

Notice that there is no System Menu box. 
Press the ESCAPE key when the scanning 
display window has the focus to close and 

return to WinSCAN. 



WinSCAN User's Guide 

 14 

Tutorial #1: 
Becoming Familiar with WinSCAN 

The previous section demonstrated how to get started quickly with WinSCAN - how to start the 
main setup program, open a previously prepared scanning display setup, run the program, and 
use WinSCAN to navigate Windows. This section goes further to introduce many other features 
and controls for WinSCAN. Here you explore the menu options for creating, printing, saving, 
loading, and customizing your own WinSCAN scanning displays for later use with Windows 
application programs. 

Begin again with the WinSCAN program icon, as shown here. 

Step 1: Insure that the SS-ACCESS USB Adapter single-switch interface is 
plugged into one of your PC's USB ports and that an adaptive switch is 
plugged into the phone jack on the other end of the adapter. 

Step 2: Using the mouse, click on the WinSCAN icon to select it and press ENTER on the 
keyboard to run the program. 

When WinSCAN runs, it displays a new WinSCAN - Untitled setup window as shown on the 
next page. This is a standard window that can be resized, repositioned, minimized, covered, or 
closed like any other application program window. The title bar indicates that the name of this 
setup is Untitled because it has not yet been saved under a particular name. The display shows all 
of the current (default) setting information about the setup. 

GENERAL SETTINGS defaults include: 

• using both the external switch connected through the SS-ACCESS USB Adapter and a 
keyboard "hot-key" (the tilde ~ key is the default) to control the scanning display 

• audible scanning prompt (NONE or OFF) 

• the speed of movement for the scanning selector (1 second per step) 

• the key repeat rate when the external switch or the hot-key is held pressed (0.25 second) 

• dwell response (activation delay) (0 seconds or NONE) 

• autostart (OFF) with no startup file identified 

• no other setup files associated with this new untitled setup 

• the default increments for horizontal and vertical mouse movements 
(10 pixels horizontal, 15 pixels vertical, per step) 

• the default setting for the drag style (increment) 
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GENERAL SETTINGS defaults (continued): 

• the default settings for the scanning display window 

• # of rows (initially 1) • # of columns (initially 1) 

• transpose (NO) … this is used for "flipping" a horizontal setup for vertical display 

• mode (horizontal scan) • style (words rather than pictures) 

• initial placement position (centered at the bottom of the screen) 

• icon size (Normal)  • scan color (Red) 

SPECIFIC SETTINGS for each position from 1 to 20 (left to right from top to bottom) in the 
scanning display include: (1) the particular mouse function, key command or WinSCAN special 
function associated with that position, (2) the number identifying the particular picture icon to be 
displayed in that position selected to represent the function or command, and (3) the particular 
word or phrase assigned to describe that function or command. Up to twenty scan positions can 
be defined. Initially all of these positions are "NULL" and "EMPTY" by default. Normally the 
first thing one would do at this point is load a previously defined setup or create and save a new 
one. 
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The next series of steps in this tutorial explore various WinSCAN menus and options. 

Step 3: Reposition and resize the Setup Window so that it is placed conveniently on your 
display screen. 

Step 4: Pull down the File menu using the mouse by clicking on the word "File" in the menu 
bar or pressing the Alt+F command key combination. 

Options to run WinSCAN, create a new untitled setup, open a previously saved setup, save or 
"save as" (under a new name) the current setup, print out the current setup information, or quit 
the program are among those displayed under the File menu. 

 

Several methods are available for opening existing setup files. A sorted list of the last (most 
recent) six previously opened setup files is displayed near the bottom of the File menu for rapid 
access. This list is empty until you have created and saved some setups. But for discussion 
purposes, the illustration above shows six setup files named General.ws, SS-Demo.ws (a single-
switch demonstration program from ASI, also found on your WinSCAN Software flashdrive), 
Dino-Games.ws (from ASI), and Solitaire.ws and Hearts.ws (for popular Microsoft card 
games). General.ws is a general purpose scanning display setup for Windows that ships with 
WinSCAN. If you have opened this file before (e.g., during the Quick Start procedure in the 
previous section), you may load this setup now by choosing it from the "recent files" list. 
Alternately you may select the Open option from the File menu or press the Ctrl+O command 
key combination and use the standard Windows File Open dialog box to select a setup file. 
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Step 5. Click on the General.ws option in the "recent files" area of the File menu. 

 

The illustration above is a preview of what the Setup Window may 
look like when you either load a previously saved setup file or are 
in the process of creating or editing a new one. In the next 
tutorial, you will create a setup for general Windows navigation 
and for playing the popular Microsoft Hearts card game. For now, 
several remaining File menu options need to be examined and the 
other menus need to be explored. 

The first of these options that we will look at demonstrates how to 
save a WinSCAN setup file. 

When saving a setup for the first time, choose the Save... or 
Save As... option from the File menu. The standard Windows File 
Save As dialog box will appear, asking you to pick the drive, the 
directory, and the filename for saving. WinSCAN setup filenames 

always end in the filetype suffix .ws. By default, the SAVE AS a WinSCAN Setup File dialog box 
displays only those files in the current directory ending in this suffix. When you type a setup 
filename in the File Name field, if you do not type the suffix, it will be added to the filename 
automatically when the setup file is saved. 
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When saving a setup that you are creating or editing under the filename displayed in the main 
setup window's title bar, choose the Save option from the File menu or press the Ctrl+S 
command key combination. If the current setup information has changed since the last save, a 
prompt message asking if you wish to save before opening another setup. 

To print out the currently displayed setup information, choose the Print option from the File 
menu or press the Ctrl+P command key combination. When you are designing a setup for a 
particular application program, printing the current setup as you create it and writing notes on the 
printout may help you plan and speed up the creation process on the computer.7 

To quit WinSCAN, choose the Quit option from the File menu or press the Ctrl+Q command 
key combination. 

Refer to the Command and Function Reference chapter 
of this WinSCAN User's Guide for detailed information 

about these and other program options and features. 
  

                                                
7  If the setup you are creating has more than 10 scan positions defined, to see and print the entire setup, reposition and 

resize the main window until all 20 scan positions are visible. Then select the Print menu option. 

Hint: It is a good idea to save all of your setup files 
in the same directory (e.g., c:\WinSCAN). 
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Continuing to explore the WinSCAN menus: 

Step 6: Pull down the Settings menu using the mouse by clicking on the word "Settings" in the 
menu bar or pressing the Alt+S command key combination. 

The Settings menu lets you individually adjust each of the general WinSCAN scanning display 
settings. The first two menu options determine whether the scanning display will contain words 
and phrases or picture icons to represent command functions. The illustrations later in the text 
provide examples of these two display types. The currently selected option has a check mark ✓ 
beside it in the menu. 

Step 7: Click on the Word Window or Picture Window option to choose words or pictures. 

The next two menu options determine whether WinSCAN will use increment (the default) or 
selection dragging when the special function Drag Window is displayed. This option is discussed 
in detail later in the Command and Function Reference chapter. 
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The Tone submenu options accessed from the 
Settings menu determine whether an audible 
tone is heard (1) each time the scanning 
display steps to a new scan key position 
(Scanning) or (2) each time the user presses 
the external switch (Response). When an 
audible prompt is active, one of these Tone 
options has a check mark ✓ beside it in the 
menu. Otherwise None is checked by default. 

 

 

 

 

The Scan Options submenu 
also accessed from the 
Settings menu controls six 
important parameters that 
determine the behavior, 
organization, and initial 
placement of the main 
WinSCAN scanning display 
window. These include: 

• the scan speed - e.g., the 
speed of the moving 
selection rectangle in the 
display 

• the scan mode - e.g., 
horizontal or vertical 
linear scanning or row/ 
column or column/row 
sequential scanning 

• the display design - e.g., # of rows and columns of scan key positions 

• the display placement - at top, bottom, or center; to the left, right, or centered on the screen 

• the size of scan icons (small, normal, or large) 

• the color of the scanning selector rectangle 
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Step 8: Pull down the Settings menu 
again and select the Scan Speed 
submenu option to open the Scan 
Speed dialog box. 

The Scan Speed... can be set to delay the 
movement of the selection rectangle in the 
WinSCAN scanning display window by .5, 
.75, 1, … 2, up to 10 seconds per step. 

Step 9: Choose the scan rate by selecting one of the radio buttons. Click the OK button to 
accept the new rate and close the dialog box. 

Step 10: Pull down the Settings menu and select the Scan Mode submenu option to view the 
sub-options available. 

Step 11: Choose one of these options to select 
either a linear scan (stepping one 
scan key position at a time 
horizontally or vertically) or a 
sequential scan (first stepping one 
entire row or one column at a time, 
then moving linearly across or down 
that column or row). The currently 
selected option has a check mark ✓ 
beside it. 

Step 12: Pull down the Settings menu and select the Design option to open the Scan Design 
dialog box. 

This option determines how the 
sequence of scan keys are displayed, 
left to right and top to bottom, in 
rows and columns. This option 
interacts with the Scan Mode option. 
If the number of rows and columns 
is reversed, the scan mode must also 
be changed - e.g., from horizontal to 
vertical - to maintain the scan key 
order while rotating the display 900. 
This is accomplished by clicking the 
Transpose Rows & Columns & Scan 
Modes button. It is a good idea to 

create your setup first by laying out the rows and columns for a normal horizontal scan. Once 
that is satisfactory, return to this dialog box and click Transpose to automatically orient it 
correctly as a vertical scan. Click the SAVE button to accept the new design and close the dialog 
box. 
  



WinSCAN User's Guide 

 22 

Step 13: Enter numbers from 1 to 20 in Rows: and 1 to 20 in Columns: data fields. (Note: The 
product of rows times columns can not exceed 20 icons.) Click OK to accept the new 
configuration and close the dialog box. 

A variety of combinations are possible. The computer will prompt if you make a mistake and 
will adjust these numbers automatically later on if you define more scan keys than rows and 
columns. (Max = 20 scan keys.) You may need to check these results again if the scanning 
display is not what you expect. 

Step 14: Pull down the Settings menu and select the Scan Options: Placement submenu to see 
available options. 

The Placement options determine the 
position of the WinSCAN scanning display 
window when it appears on the screen - e.g., 
at the top or bottom, centered and aligned at 
the left, right or center of the screen. 

Step 15: The Placement submenu must be 
opened twice. First, click the 
placement choice. Second, click 
the alignment choice. Check 
marks ✓ appear beside each 
current choice. 

Step 16: In a similar fashion, pull down the Settings menu and select the Icon Size submenu to 
choose Small, Normal, or Large icon scan keys. (Note: Choosing large icons may 
limit the number of icons that can be displayed horizontally or vertically in the 
Scanning Window. On the other hand, small icons may be difficult for users to see and 
recognize easily. Choice of size may also depend on your display screen resolution.) 

Step 17: Pull down the Settings menu and select the Scan Box Color submenu to choose a color 
for the WinSCAN scanning selector rectangle that is easy for the user to see. Options 
include Red (the default), Blue, Yellow, Green, or Custom. Choosing Custom opens a 
standard Windows Color Picker dialog box offering a full range of custom color 
choices. 
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A number of other important settings are also accessed through the Settings menu. These 
include: the external switch or keyboard hot-key Repeat Rate and Dwell Response rate; whether 
or not WinSCAN automatically opens and runs a particular setup each time it starts up (very 
useful to set a setup file such as General.ws as a StartUp file to open WinSCAN and run 
automatically whenever your computer is turned on and Windows boots up or restarts); whether 
and which setup files are associated with the currently loaded setup (and can be switched to 
automatically using the WinSCAN Control Panel special function scan key) and finally how far 
the mouse cursor moves horizontally and vertically when Mouse Left, Right, Up, or Down 
functions are selected by the user. 

Step 18: Pull down the Settings menu and select the Dwell Response submenu option to open 
the Dwell Time Delay dialog box. 

The Dwell setting determines the 
delay between the moment the user 
presses the external switch and the 
moment when WinSCAN actually 
sends the selected scan key command 
to Windows and to the running 
application program (which has the 
focus). Such a delay may be 
necessary in some cases to give the 
user time to attend the screen where 
the action takes place. The Dwell Response also occurs after (and in addition to) each switch or 
hot-key Repeat cycle if the switch or hot-key is held pressed down. 

Step 19: Click a radio button to select a Dwell time delay and click the OK button or click 
Default to accept the default value of None for the dwell and close the Dwell Time 
Delay dialog box. 
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Continuing to explore the Settings menu: 

Step 20: Pull down the Settings menu 
and select the Switch Control 
option. 

If the SS-ACCESS information field 
(the first information item shown in the 
main Setup Window) displays On-Line, 
then the external switch is always 
active. The Switch Control submenu 
allows the user to select a keyboard hot-
key that will also act as a "switch key" 
when pressed. If the SS-ACCESS USB 
option is checked, then there is no hot-
key. But if Hotkey is checked, one of three options can be selected (the Tilde Key (~), the 
Spacebar, or the F11 key).8 

Step 21: Pull down the Setting Menu and select the Switch Repeat Rate ... option. 

The Switch Repeat Rate affects 
functions such as mouse cursor 
movement, dragging, and keystroke 
entry which continue as long as the user 
holds the external switch closed or the 
hot-key pressed. The repeat rate can be 
set to be the "same as the scan speed" 
or it can be adjusted independently. 
Options include repeat rates  of .1, .25, 
.5, 1, 1.5, 2, and 2.5 seconds. The 
repeat rate also can be set "as fast as possible" (which means on most computers, about 15 
repeats per second). 

Step 22: Choose the repeat rate by selecting one of the radio buttons. Click the OK button to 
accept the new rate and close the Switch Repeat Rate dialog box. 

 
The Switch Repeat Rate option helps single-switch users 

who can release their switch much faster 
than they can activate it. 

  

                                                
8  A fourth Hotkey sub-option "Custom" is not currently implemented. However, future upgrades may allow the user to 

select other keyboard keys to become the "hot-key." Note: Beware that choosing a hot-key prevents that particular 
key from being sent to an active Windows application when using the main Scanning Window. However,  the Text or 
Text Plus special function windows operate normally. 
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WinSCAN's 

AutoStart feature 
provides 

fully independent 
access to your 

computer! 
 

The AutoStart… option is one of the most important features of WinSCAN from the point-of-
view of fully independent computer access. Although the WinSCAN program icon can be placed 
in the Windows Startup directory and will start automatically when Windows starts or restarts on 
your computer, normally this would only bring up the WinSCAN Setup Window. However, by 
using a Setup file with the AutoStart option activated, WinSCAN will load it (or another 
previously identified startup setup file) automatically and go immediately into the scanning 
display mode without operator intervention.9 The following steps demonstrate how to turn 
AutoStart ON and OFF and how to select the AutoStart setup file. 
Step 23: Pull down the Settings menu and click on the AutoStart… option. The AutoStart dialog 

box will open as shown above. 

Step 24: To activate the AutoStart feature, use the mouse or the TAB, SPACE, and ENTER 
keys to select the radio button labeled Yes in the frame with the question "Should 
WinSCAN autostart the selected Startup Setup file?" To deactivate this feature, select 
the radio button labeled No. (This is the default setting.) 

Step 25: If AutoStart is activated, the setup will run immediately when opened. Alternately, you 
can give WinSCAN the complete pathname to another setup file that it should load and 
run automatically at startup. For example, if you performed the recommended 
WinSCAN installation, you may wish to choose the General.ws setup. In that case, 
open that setup, go to this dialog box, click the YES button, click OK, and save the 
file. To select a different StartUp Setup file, click the "... identify the Startup Setup file 
… " field shown in the dialog box. A standard Windows Open File dialog box will 
appear. Choose the drive and directory that contains your setup files (typically that 
would be c:\WinSCAN). Select the setup file you want and click OPEN. The full 
pathname to this file will appear in the AutoStart filename field. Repeat this procedure 
to select a different StartUp Setup file or click the CLEAR button to void the field 
entry. 

Step 26: Click the OK button to accept these new settings or click the Cancel button to ignore 
them. This will close the AutoStart dialog box.  

                                                
9  A better, recommended way to set this up is to place a shortcut to the General.ws setup file (usually located in your 

c:\WinSCAN folder) in the Windows Startup directory. Since the WinSCAN Installer configures Windows to use 
WinSCAN as the default application when opening WinSCAN Setup files (with filenames ending with the filetype 
suffix .ws), WinSCAN will start automatically and open (and run, if AutoStart is ON) this setup when your computer 
is started or restarted. More information about this procedure is provided in the Technical Information chapter of this 
User's Guide. 
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The Associated Files... option is an advanced feature of WinSCAN to enhance fully independent 
computer access. The Associated Files ... dialog box shown above allows the setup designer to 
identify up to five other previously defined and saved WinSCAN setup files - customized, for 
instance, for particular games or applications - that will be associated with the current setup file 
being created or edited. This feature works together with the Control Panel special function scan 
key to allow the single-switch user to modify WinSCAN options and link to a different setup 
from the one that is currently running. If the user selects a new setup file, that setup loads and 
runs immediately when the user quits the Control Panel. If the newly loaded scanning display 
setup also includes the Control Panel scan key and if the new setup was defined as associated or 
linked to the previous setup, then the user can move back and forth among these and other linked 
setups in any pattern. 

Since each setup allows up to 20 scan key functions, including the text windows and other 
special functions, Associated Files... gives the single-switch user access to up to 120 different 
scan keys arranged in up to 6 groups. Even deeper hierarchies can be constructed. For example, 
one setup for general purpose Windows navigation can be linked to 5 other setups designed for 
specific programs, each of which possibly linked to still other setups designed for sub-sections or 
functions within programs. Custom setups normally are more efficient ways to access specific 
programs than are general purpose setups. This is because the more scan positions there are that 
are not needed, the more time it takes to access those functions that are required frequently. 
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The following steps demonstrate how to define associated setup files. 

Step 27: Pull down the Settings menu and click on the Associated Files ... option. The Associated 
Files... dialog box will open. 

Step 28: To set up a link to an associated setup file, you must give WinSCAN the complete 
pathname to that file. For example, in addition to the General.ws setup, another setup file 
(one for the Microsoft Solitaire card game) is shipped with WinSCAN. If you performed 
the recommended WinSCAN installation, you may wish to click on the File 1 field and 
locate the c:\WinSCAN\Solitare.ws setup file using the Open File dialog box. Associate 
other setup files in a similar fashion by clicking the File 2, File 3, or other fields as 
well.10 

Step 29: Click the OK button to accept these new settings or click the Cancel button to ignore 
them. This will close the Associated Files ... dialog box. 

To complete our tour of the Settings menu: 

Step 30: Pull down the Settings menu and select the Mouse Jump... option. 

The Mouse Jump distance in pixels is how far 
the mouse cursor will move when the user 
selects mouse movement functions using the 
WinSCAN display. Values can be from 1 to 400 
pixels per jump. (The defaults are 10 pixels 
horizontal and 15 pixels vertical per move.) 
Mouse movements continue at the "repeat rate" 
speed setting as long as the user holds the 
external switch or hot-key closed. Smaller 
increments give better control but require more 
time to move a given distance. (In addition to 

this option, WinSCAN also features precision mouse cursor control for movement and dragging 
operations. Read more about this in the Command and Function Reference chapter of this User's 
Guide.) The dialog box allows you to enter distances for horizontal and vertical travel 
independently and to preview how the mouse will behave by clicking the Test Up or Test Left, 
etc., buttons (followed by the ENTER key to repeat) before leaving the dialog box. 

Step 31: Click the OK button to accept the movement settings and close the Mouse Jump 
dialog box. 

  

                                                
10  Should these files be moved or deleted later on, when the Control Panel opens, WinSCAN will ignore the request to 

link to an associated file that no longer exists. 
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The menu that you will use the most with WinSCAN is the Scan Keys menu. This menu's View 
Pictures options provide visual access to the built-in library of picture icons used when designing 
WinSCAN display setups. This menu also allows you to access each of the 20 "scan key" 
positions that may comprise a WinSCAN scanning display and to define the properties 
associated with each of these positions using the Define Position # dialog box. Once a set of scan 
keys is defined, the Edit Positions submenu accesses functions you can use to rearrange your 
scanning display by inserting, moving, switching, or deleting scan key definitions in the main 
WinSCAN Setup Window. 

Step 32: Pull down the Scan Keys menu by clicking on the phrase "Scan Keys" in the menu bar 
or pressing the Alt+K command key combination. Select the View Pictures option or 
press the Ctrl+V command key combination. 

This step opens the Picture Choices window initially located at the upper right hand portion of 
the Setup Window. This window can be resized and repositioned anywhere on the screen. It 
presents a useful subset of 90 picture icons (30 at a time), many of which were selected from the 
KeyPics picture library published by Academic Software, Inc. KeyPics is a library originally 
designed for constructing picture overlays for persons with disabilities who rely on alternate 
keyboards to provide computer access and to control games and other application software. 

Step 33: Click inside the Picture Choices window to switch from one screen of icons to another 
or click the Close button at the right end of the title bar to close the window. 

Sixteen icons (the mice, arrows, hands, and faces) are preset to be used to represent mouse 
movement directions and ARROW key functions. Several icons represent clicking or double-
clicking the left or right mouse button. Other special icons elicit special scanning displays for 
dragging functions, text entry, and the control panel. Eleven labeled key icons represent the 
ENTER, TAB, SPACE BAR, and other commonly needed key commands. There are general 
purpose icons to represent game control functions like STOP and GO and HOME and JUMP. 
Other icons to represent functions needed to access the Internet and work with e-mail. Finally 
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there are several general purpose graphics to represent other functions one might need to operate 
a particular program. For example, you could use the "PAWS" icon to represent functions such 
as "pause" or "help." 
The Picture Choices window is for viewing only. You do not click on these icons to select them. 
Instead each icon is numbered. However, this window can be moved and resized to a convenient 
location where you can see it easily while creating your setup.11 

 

 

 

 
Click inside the Picture 

Choices window to toggle 
from one icon screen to 

another. 

 

 

  

                                                
11  The Picture Choices window can overlap information fields on the main Setup Window. Likewise, the Design 

Position # dialog box always appears in the middle of the display screen. We recommend repositioning and enlarging 
the Picture Choices (if you have a high resolution display) to view both the setup information and the picture choices 
when editing or constructing a new setup.  The Design Position # dialog box can also be repositioned if needed. 
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Step 34: Pull down the Scan Keys menu and 
select the Define Positions option 
or press the Ctrl+D command key 
combination. 

This step opens the Define Position # dialog 
box shown below.12 This option is used to 
assign a specific mouse function, key 

function, combination key command, or special function to each scan position in a WinSCAN 
display. In addition, this is where picture icons and descriptive words or phrases are associated 
with each scan key position. This important dialog box is described in detail in the Command 
and Function Reference chapter of this User's Guide. But how one uses it to create WinSCAN 
scan key setups is learned best by example. In the next chapter, we make extensive use of this 
dialog box to create a custom setup for navigating Windows and playing the Microsoft Hearts 
card game. 

Step 35: Click the Done button to 
close this dialog and 
return to the main 
WinSCAN Setup Window. 

 

The Scan Keys: Edit Positions sub-
menu also is described in detail in 
the Command and Function Refer-
ence chapter. Once a WinSCAN 
setup has been opened or created, 
the scan key positions that have been 
defined can easily be rearranged, 
new scan keys inserted in selected 
positions, and/or existing ones 
removed from the setup. This 
submenu is pictured below: 

 

 

 

  

                                                
12  Clicking inside any particular row of the setup Position Information datagrid displayed in the middle of the main 

Setup Window is also a quick way to open the Define Position # dialog box. 
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Tutorial #2: Creating WinSCAN 
Scanning Display Setups 

 

In this chapter you will learn how to design, create, save, and customize a WinSCAN setup for 
the popular card game of Hearts. The Microsoft Hearts game program, which either comes with 
the Windows operating system software or can be downloaded and installed as an "app" on most 
PC computers, will be our example program. If you do not have Hearts installed on your 
computer, you should still complete this tutorial because, with slight modification, the setup you 
will build can be adapted easily as a general setup for navigation through the Windows 
environment and for use with other programs and games. 

The first thing to do when designing a WinSCAN scanning display setup is to run the target 
application program yourself and review the menus and help files and other documentation that 
come with the program or game. Pay particular attention to the basic mouse functions and 
keyboard commands that you as the user need in order to operate the software. If it helps to do 
so, write down these functions and arrange them in the order of their importance in terms of their 
frequency of use or necessity to control the software. 

The illustration on the next page shows a PC screen as it might appear when running the Hearts 
game program under Windows. Other windows have been closed or minimized and are out of the 
way. The WinSCAN display setup which we are going to create is shown running and if the user 
pressed the external adaptive switch now, a Left Click message would be sent to the Hearts 
game, just as if the user had clicked the mouse at this moment in time. The Hearts program 
would pass the three cards "Bob" has selected to the left. 

A little study and practice with the Hearts game reveals that it is almost entirely mouse-driven. 
To play the game, we need to be able to move the mouse right and left and up and down and to 
be able to click on whatever spot on the display that we choose (normally on our cards). To 
operate the game menus efficiently and navigate through any dialog boxes that may appear, we 
also need the ENTER key and perhaps the TAB key as well. At one point, the program asks the 
user to type his or her opponents' names. For this, we need full text entry capability. Looking at 
the Game menu, we notice that the F5 function key brings up Options and the F4 function brings 
up the Game Score Board.13 The Score Board, in particular, would be of benefit to have 
available to the user during game play. With these basic functions, the single-switch user can 
have independent control of every aspect of the game of Hearts. Furthermore, with these 
functions, the user can quit the game and return to Windows to play something else whenever he 
or she wishes to do so. 

  

                                                
13  Other pre-defined menu functions for Microsoft Hearts include: Help (F1), New Game (F2), and Change Appearance 

(F7). 
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Other design features are also important to notice. The Hearts game is played in a rectangular 
window almost as high as the screen itself. So a vertical rather than horizontal scanning display 
might be preferred. A good place for the scan is at the top or in the center to the far left of the 
screen. Using words rather than pictures for a user who can read allows you to choose a 
descriptive phrase like "Score Board" to represent the function associated with the F4 key. We 
chose not to include the Enter or Tab key in the main scanning display. Instead we included the 
special function Text Plus scan key which accesses an alternate scanning display containing 
these and many other useful functions. Notice that during the play of the game, individual cards 
are played by being selected and clicked on using the mouse. The cards appear to be spaced 
fairly close together. Mouse movements to the right and left in 10 pixel steps will work here. We 
could omit Text Plus and instead use the Control Panel. The user could link to and from the 
General.ws setup for occasional text and command key entry. These kinds of considerations go 
into creating good scanning display setups that take full advantage of the flexibility WinSCAN 
offers. 
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To create the WinSCAN setup we have designed for the Microsoft Hearts game, follow these steps: 
(If necessary, refer to the Quick-Start instructions in the previous chapter.) 

Step 1: Make sure your external switch is plugged into the SS-ACCESS USB Adapter and that 
the adapter is plugged into USB port on or connected to your PC. Start WinSCAN by 
double-clicking the WinSCAN program shortcut icon on your Desktop. (If WinSCAN is 
running already on your PC, click on the New option from the File menu). The Setup 
Window should appear with "Untitled" showing in the title bar. Note that the SS-ACCESS 
information field should indicate "On-Line" and the Switch Control field should indicate 
"Using the Tilde Key" which is the default hot-key setting. 

Step 2: Pull down the Settings menu and note that the Word Window option is checked. This is the 
default display type. 

Step 3: Pull down the Settings menu and note that the Increment Drag option is checked. This 
default drag mode will work well with Hearts. 

Step 4: Pull down the Settings menu and highlight the Tone submenu. Note that the None option is 
checked. This is the audible tone default setting. 

Step 5: Pull down the Settings menu and highlight the Scan Options submenu. Note the six options 
that control the appearance and behavior of WinSCAN's main scanning display. Choose 
the Speed option. Click on the 1.0 second radio button in the Scan Speed dialog box. Then 
click on the OK button. This sets the scan speed. (Choose a slower scan speed when 
appropriate.) 

Step 6: Pull down the Settings menu, highlight the Scan Options submenu, and choose the Mode 
option. Select the Vertical option. This sets the scanning selector direction and motion. 

Step 7: Pull down the Settings menu, highlight the Scan Options submenu, and choose the Design 
option. The number of scan key rows and columns in your design is requested. Enter 1 
row and 8 columns. Since this will be a vertical scanning display, click the Transpose… 
button.14 Then click on the OK button. This configures the scanning display. 

Step 8: Pull down the Settings menu, highlight the Scan Options submenu, and choose the 
Placement option. Click on Left. Repeat this process a second time to click on Align 
Center. Click on the OK button to accept this initial position for the display.15 

Step 9: Pull down the Settings menu, highlight the Scan Options submenu, and choose the Dwell 
Response option. Note the None radio button is selected. Click on the OK button to accept 
this default for dwell time. Accept the Icon Size and Scan Box Color defaults. 

  

                                                
14  Actually, since this is going to be a single column scanning window, you could have simply entered 8 rows and 1 

column. "Transpose" is useful for properly flipping a multi-row and column scanning window design. 
15  The main Scanning Window can be repositioned manually with the mouse when it is running, but not by using 

WinSCAN mouse functions. 
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Step 10: Pull down the Settings menu and click on the Switch Repeat Rate ... option. Click on 
the ASAP radio button in the dialog box. Then click on the OK button to set this repeat 
rate. 

For now, skip the AutoStart and Associated Files ... options in the Settings menu. How these 
advanced features work are described in the next Tutorial and detailed in the Command and 
Function Reference chapter of this User's Guide. 

Step 11: Pull down the Settings menu and click on the Mouse Jump option. Insure that the 
horizontal movement setting (Left/Right) is 10 pixels and the vertical movement 
setting (Up/Down) is 15 pixels. These default values will work well for Hearts. Click 
on the Test buttons and use the ENTER key to test the mouse jump movement. Click 
on the OK button to set these options. 

Notice that as each one of these changes was made, the information displayed in the Setup 
Window changed to reflect the new setting. 

Step 12: Now pull down the File menu and click on the Save As... option. The standard 
Windows File Save As dialog box will appear. Give the setup you are saving the 
filename Hearts.ws and insure that it is being saved in the same directory (probably 
the c:\WinSCAN directory) you created for WinSCAN setups. Then click on the Save 
button to save your new setup. Following the save operation, the dialog box will 
disappear and the Setup Window title bar will identify your setup as Hearts.ws. This 
file will also appear in the Recent Files submenu listing. 

Next we will begin to define the eight scan keys that will appear in the scanning display for 
Hearts. To do this, we first choose the View Pictures option from the Scan Keys menu to call up 
and position the Picture Choices window. You may want to reposition and/or resize this window. 
Next we choose the Define Positions option from the Scan Keys menu and use the Define 
Position # dialog box repeatedly and in sequence to define the key positions. You may want to 
reposition this window too, as shown in the illustration below.16 Each time we create a key, the 
information for that key will appear in the Setup Window Position Information datagrid. When 
we are finished, we will save and print the setup. Then we will run WinSCAN and use the new 
scanning display to select, run, play, and quit the Hearts game. 

  

                                                
16  Whether you can do this reposition/resize operation to good advantage depends upon the resolution of your display 

monitor. However, even on low-resolution monitors or laptop screens, you can still see the entire WinSCAN Setup 
Window and the initial small Picture Choices window. The Define Positions # dialog box always opens in the center 
of the screen below the Picture Choices window. It may cover the Positions Information datagrid temporarily. 
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The Define Position # dialog box can be tricky to use at first. The parameters for a new key need 
to be defined in a certain order. Be sure to follow the step-by-step instructions very carefully at 
first until you become familiar with the definition process. 

Step 13: Press the Ctrl+V command key combination to call up the Picture Choices window. 
This small box of graphics will appear at the top right corner of the Setup Window. It 
can be repositioned and resized. 

Step 14: Pull down the Scan Keys Menu and select the Define Positions option. The Define 
Scan Position # dialog box will appear in the center of the display screen. Reposition it 
too if necessary.17 

The "#" in the Define Position # title bar and the Position frame indicates the current scan key 
position in the list. Initially, this number will be "1" as shown in the illustration. 

  

                                                
17  Alternately you can click inside row 1 of the Setup Window Position Information datagrid to open the Define Position 

# dialog box showing Position #1. 
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The order in which you define scan keys when creating a setup is important. Mouse movement 
functions are required most frequently in Windows so these keys should be defined first. A 
suggested order is Mouse Left, Mouse Right, Mouse Up, and Mouse Down. The next most 
frequently needed functions are Left Mouse Click and Double Click. Least often needed (and 
therefore logically to be placed last in the scanning sequence) are scan keys such as those for 
controlling the Game Score Board and other functions specific to the Hearts game as well as 
special keys for functions such as dragging or text entry. We will begin with the mouse 
movement functions. 

Order is also important when you define a scan key using the Define Position # dialog box. It is 
best to (1) choose the mouse, keyboard, or special function, (2) change the picture choice if 
desired, (3) change the associated word or phrase if desired, then (4) save and advance to the 
next scan position. 

Step 15: Click on the Mouse Left radio button in the Mouse Functions group. 

Notice that the number in the text field labeled Picture Choice changed from 0 (the default blank 
picture) to 1. Picture #1 is the Mouse Left icon displayed in the Picture Choices window. This is 
the default icon for the Mouse Left function. There is always a standard icon associated with each 
mouse function, special function, and some keyboard keys and its number is placed 
automatically in the Picture Choice text field (overwriting the previous selection). At this point, 
you can change the icon by typing any number from 1 to 90 in this text field. 

Note also that the top and bottom Scan Word text fields changed from EMPTY to Mouse Left. 
There is always a standard word or phrase associated with each mouse function, special function, 
or keyboard key. This word or phrase is placed automatically in the text fields each time you 
enter or change the function or character(s) associated with the scan position or the associated 
Picture Choice number, over-writing whatever was in these text fields previously. At this point, 
you can change the word to any other word (max=6 letters) by selecting and editing either of the 
Word text fields. 

 (There is also a non-editable data field called Function. This field is for information purposes 
only and is filled in automatically by WinSCAN. Of course it needs to be the function or 
character that you intended to define. The picture and the text words can be changed AFTER a 
pre-defined function is selected.) 

Step 16: Click the Save Position button to accept the settings for the first scan key. The 
definition for Position #1 appears in the Setting Window datagrid scan key list. 

Step 17: Click the Next button in the Position frame to move to scan position #2. 
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WinSCAN keeps track of any changes you 
make in the definition of a scan key position. 
Had you inadvertently skipped Step 16 and not 
clicked on the Save Position button before 
closing the dialog box (by clicking on the Done 
button) or before attempting to move to the 
Next or Previous position, an alert box would 
appear, as shown to the right, asking if you 
wished to save your changes. 

The next series of steps repeat the definition sequence you followed in Steps 15-17 to create scan 
keys for the remaining three mouse movement directions and the Left Click function. At this 
point, the current Define Scan Position should be #2. 

Step 18: Click the Mouse Right radio button in the Mouse Functions group. Let Scan Words 
default to Mouse Right and the Picture Choice default to #2. Click the Save & Adv 
button to accept the settings for the second scan key and to move to position #3. 

Step 19: Click the Mouse Up radio button in the Mouse Functions group. Let Scan Words 
default to Mouse Up and the Picture Choice default to #3. Click the Save & Adv 
button to accept the settings for the third scan key and to move to position #4. 

Step 20: Click the Mouse Down radio button in the Mouse Functions group. Let Scan Words 
default to Mouse Down and the Picture Choice default to #4. Click the Save & Adv 
button to accept the settings for the fourth scan key and to move to position #5. 

Step 21: Click the Left Click radio button in the Mouse Functions group. Note that the standard 
phrase for this function is Left Click. The Function name (supplied by WinSCAN) is 
LMouseClick. The standard Picture Option number is 5. Accept all of these defaults 
and click the Save & Adv button to accept the settings for the fifth scan key and to 
move to position #6. 
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The next series of steps associate the sixth scan key position with the F4 function key on the 
keyboard. When the Hearts game screen is active (has the focus) and our custom WinSCAN 
scanning display is running, pressing the external switch when the scan reaches this position will 
send an F4 keystroke to the game program. Hearts will display its Score Board. 

Step 22: Locate the Key Stroke button inside the Keyboard Functions frame in the Define 
Position # dialog box. This control is used for assigning a single keystroke to a scan 
key. Click on the Key Stroke button. The following message prompt will appear in 
the middle of the screen: 

 

 At this point, press the F4 function key on the keyboard. Note that the standard Scan 
Words for this keystroke is F4 Key and the default Picture Choice for such keys is 38 
(a blue Paw icon). The Function is, of course, also F4. 

Step 23: Consider the picture icons showing in the Picture Choices window. Click 
inside that window to change picture screens. Icon number 35 is a good 
choice to represent Score Board. Type the number 35 corresponding to this 
icon in the Picture Choice number field. 

Step 24: Press the TAB key to reach the Scan Word (top) text field. Replace the word F4 with 
the custom word Score. Press the TAB key and edit the Scan Word (bottom), replacing 
the word EMPTY with the custom word Board. Click the Save & Adv to accept the 
settings for the sixth scan key and move to position #7. 

Note that if you had wanted to define a Combination Key - e.g., Shift+A for capital "A" or 
Ctrl+F4 or ALT+F - then you would have clicked the Combination Key button. Two message 
prompts would occur. The first would ask you to press the first keystroke in the combination. 
The second prompt would ask for the second keystroke in the series. Only two-key combinations 
involving Shift, Ctrl and Alt as the first keystroke can be defined. Do not press down both 
keys at the same time. 

When the Hearts game starts, it opens in a window. During play, several dialog boxes may also 
open. Since one can not be sure exactly where these elements will appear on the screen or what 
size they may be, it is handy to be able to drag and resize Windows objects when necessary. 

In addition, when the Hearts game starts, it may open a dialog box with a text field prompting 
the player to type his or her name or the names of the opponents. This requires text entry 
capability. Moreover, making selections, opening and closing dialog boxes, and similar tasks 
either require or can be accomplished most efficiently by keyboard data entry - e.g., pressing the 
ENTER or TAB key or using the SPACE BAR. There are many ways to design different setups 
with different functionalities. 
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WinSCAN has several built-in special function scan keys and special function secondary 
scanning displays to help the single-switch user accomplish these tasks. These special functions 
are demonstrated in the next tutorial and discussed in detail later in the Command and Function 
Reference chapter. But for now, dragging is a mouse function and the scan key for this special 
function is defined in the Mouse Functions group in the Define Position # dialog. Text entry is a 
keyboard function and its scan key is defined using either the Text Plus button or the Text 
(Only) button. (The Text Plus scanning window can also perform mouse and drag functions.) 

Step 25: To give the user control over most WinSCAN settings and possibly allow automatic 
switching to other associated setups, click the Control Panel button, followed by the 
Save & Adv button to accept the settings for the seventh scan key and move to 
position #8. 

Step 26: Click the Text + button in the Define Position # dialog box. Let Scan Words default to 
Text Plus and the Picture Choice default to #7. Click the Save button to accept the 
settings for the eighth scan key. 

Step 27: Click the Done button to close the Define Position # dialog box. Click the Picture 
Choices window title bar Close button to close the Picture Choices window as well. 

Your WinSCAN Setup Window should resemble the illustration on the next page, except for the 
scan keys for the Control Panel and for the Text Plus functions which appear in positions 7 and 
8. The user probably will need the Text Plus function more frequently than the Control Panel, so 
let's swap the contents of these two positions in the scanning sequence. WinSCAN provides an 
easy method to insert, move, switch, or delete scan key definitions. 

Step 28: Pull down the Scan Keys menu and 
select the Edit Positions... option. From 
the Edit Positions submenu, select the 
Switch... option. The Switch Two 
Positions dialog box will open, as shown 
below. 

 

Step 29: Type the number 7 in the first data field in 
the Switch Positions dialog box. Type 8 in 
the second field. Click the OK button to 
switch the two scan key positions and 
close the dialog box. Observe that the 
positions are now switched in the Setup 
Window Position Information datagrid. 
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At this point, your Setup Window should look almost exactly like the illustration below. Notice 
that you may be able to enlarge the Setup Window to see the entire Scan Position datagrid. This 
is particular useful for printing the setup information. (Otherwise you would need to use the 
datagrid vertical scroll bar to view and print the last ten positions.) 

Step 30: Press Ctrl+S to save the finished setup. Press Ctrl+P to print out a permanent record 
to document your hearts.ws setup. 

Congratulations on completing your first WinSCAN custom setup. 
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More Thoughts About Setup Design: As we mentioned earlier in this chapter, the first thing to 
do when creating a WinSCAN setup is to familiarize yourself thoroughly with the software 
program for which you intend to create a setup. The second step is to write down each of the 
mouse functions and keyboard commands needed to run the program efficiently. Reviewing the 
software manual to identify any keyboard shortcuts always helps. The third step is to choose 
icons and text phrases that best represent the control functions as scan keys. Next, you need to 
consider how the scan keys can be best arranged in rows and columns for scanning display 
efficiency. Finally, there may be therapeutic and/or educational factors to take into account, such 
as scan complexity, speed, repeat rate, activation delay (dwell), and so forth. Always keep in 
mind that the goal is for the single-switch user to be able to (1) operate the software successfully, 
(2) with the least number of switch activations possible, (3) in the least amount of time, and (4) 
with the least amount of frustration. 

WinSCAN ships with setups for general navigation, Solitaire, and several other programs. If you 
completed this tutorial, you now also have a setup for Hearts. At the end of this chapter, we 
reprint two of many WinSCAN Setup Forms available for downloading from the Internet.18 
Features of these designs are discussed below. Also at the end of this chapter is a table of the 90 
picture icons built into WinSCAN, together with suggestions about how these might be used to 
represent specific scan key functions needed to run Windows software. With these examples as 
resources, you should be off to a good start. 

Choosing Appropriate Scan Key Functions: Consider the Solitare.ws setup shipped with 
WinSCAN for the popular Microsoft Solitaire game. The computer game is played exactly as the 
regular card game is played. You could use either the mouse functions or the keyboard 
commands to pick up, move, and turn over the cards. Either would work to run the program, but 
the keyboard commands greatly reduce the number of switch activations necessary. They do not 
require the user to hold down the switch to move the mouse cursor and they eliminate the 
possibility of “overshooting” the mark since the "card selector" is constrained to the cards and 
does not “float” like the cursor arrow does under mouse control. Using keyboard commands 
generally accelerates the play of the game. On the other hand, a setup that has no mouse 
functions creates its own access problems. This problem can be remedied easily either by 
including the Text Plus special function scan key or by linking to the General.ws setup via the 
Control Panel. 

For a setup (described below) designed to work with the popular Living Books CD, Arthur’s 
Teacher Troubles, both keyboard commands and mouse functions were included in the design. 
Mouse movements are needed to navigate freely through the interactive screens that make the 
Living Books software so popular. Keyboard commands were used to turn the pages and leave 
the program. 

  

                                                
18  Visit Academic Software, Inc. on the web at http://www.acsw.com. 
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Choosing Icons to Represent Functions: Setups are more than collections of mouse functions 
and keyboard commands. The icons and words chosen to represent these functions also play a 
role in the design, making the setup more intuitive and more fun to use. Choosing icons that 
closely represent their corresponding functions is an important design aspect. With the Arthur’s 
Teacher Troubles setup, we used the mouse-going-out-the-door-marked-exit icon to represent 
leaving the program. Mouse movements are represented by hands-pointing-left, -right, -up, and –
down. However, a person who routinely uses eye-gaze to denote direction might find more 
appropriate the icons showing faces-looking-to-the-left, -right, -up, and –down. Other icon 
choices to represent the mouse movements include the mouse icons and the arrow icons. 

Arrow icons were not used to indicate directionality in Arthur’s Teacher Troubles because the 
right and left arrow keys are used consistently throughout Living Books software to turn the 
page. Instead we chose icons representing pages-being-turned-forward and –backward for these 
functions. 

In the Solitaire setup, we chose the jumper icon to represent the cursor jumping from the deck to 
the suit stack to the row stacks. The deal-a-card icon was selected to be the scan key used to turn 
over, pickup, and drop selected cards. The menu scan key is used to select the game menu. The 
arrow icons are used in this setup to represent the arrow keys on the keyboard that control the 
cursor position. These work together with the Alt scan key to access the game menus. There are 
numerous other ideas for icon/scan key combinations. We suggest some common program 
functions that could be represented by each library picture icon at the end of this chapter. 

Icon Placement: The placement of scan keys within the scanning display is also an important 
design feature. The most commonly used functions should be placed first. In most programs that 
would be the mouse movements. However in the Solitaire setup, the Enter/Deal-a-card scan key 
is the most frequently used function, followed by the arrow keys, double click, then the jumper. 
The Control Panel, menu, and Alt scan keys are the least frequently needed functions when 
playing Solitaire. 

When you are using multiple rows and columns, place the most frequently accessed functions 
toward the upper left corner of the scanning display. Consider the WinSCAN General.ws setup, 
for example. This setup contains 16 scan keys, arranged in 2 rows of 8 columns. The mouse 
movement scan keys are the first functions placed in row 1. The arrow scan keys are the first in 
row 2. These functions are used most frequently and repeatedly for general navigation on screen 
and within text fields. The mouse scan keys are followed by left click, double-click, and Enter, 
also accessed frequently but as singular events typically following repeated mouse cursor 
movements. The Control Panel and Text Plus are less frequently needed but still important to 
allow user switching between other setups and/or need for occasional access to general functions. 
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Therapeutic and Switch Training Design Considerations: Going from basic single-switch 
cause-and-effect programs and simple single-switch training activities such as Dino-GAMES or 
Multi-SCAN from Academic Software, Inc., or even some higher-level single-switch software 
packages such as First Verbs or Sentence Master from Laureate Learning Systems, Inc., to using 
WinSCAN to navigate the Windows desktop and operate Windows software such as Microsoft 
Office applications or Internet Explorer or other web browsers can be a challenge. When 
working with beginning WinSCAN users - especially with younger children - you may wish to 
limit the number of scan keys available at first to insure success and reduce frustration. 

Consider Arthur’s Teacher Troubles again as an example. You could begin with a scanning 
display containing only one or two scan keys: e.g., two scan keys representing page turning 
actions. In an interactive setting, one child could turn the multimedia pages using the switch, 
while another child explored the activities on each page using the mouse. Later the scanning 
display could be expanded to include the mouse left click function. The child using the single-
switch then could choose the working page and start the action as his or her companion moved 
the mouse over objects to animate on the screen. Eventually, the single-switch user could work 
up to independent play. 

Selecting appropriate values for other setup parameters such as scan speed, repeat rate, and dwell 
with young children involves some experimentation. Including the Control Panel scan key in the 
setup design provides older users with independent access to these control settings so that they 
can be adjusted to suit capabilities dynamically. Non-readers and children with visual 
impairment may do better with pictures rather than words as scan keys. They may also benefit by 
setting the computer display mode to use larger text fonts or a reduced display resolution (rather 
than using a higher resolution mode which often displays smaller screen images and text). You 
may also want to consider using the simpler Text Only special function (rather than Text Plus) 
with young children for text entry. 

WinSCAN Setup Download Library: The following pages represent a sampling of setups from 
our WinSCAN Setup Download Library available at Academic Software’s web site at 
http://www.acsw.com. Setups for popular games, book readers, science education software, 
general education software, telecommunications software, productivity software, and 
miscellaneous software are posted in this library. Teachers, parents, therapists, or WinSCAN 
users are welcome to download these setups freely for their own uses. If you have designed a 
particular WinSCAN setup that you would like to share with us, please send it to us to share via 
the Internet or through the mail. 
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WinSCAN 3.0 Setup #1101 ....................................................... solitare.ws 

  

Software Summary 

Solitaire is a single-player card game to challenge one's skill and luck. The object of the game is 
to build row and suit stacks, moving cards from play on the deck to either a row or suit stack 
with the hope of building all four suit stacks before running out of play options. 

Scanning Display 

 

Startup: Use the General WinSCAN display setup to open the Solitaire program. Insure that the mouse cursor is 
over the Solitaire program window. Select the Control Panel scan key (#8) to change setups. Choose the Solitaire 
setup (Solitare.ws). Then select quit from the control panel. The Solitaire game is now open with the new scanning 
display setup running. However the Solitaire program does not have the focus. To re-select Solitaire, insure that the 
mouse cursor is positioned over the Solitaire window. If so, choose the Double Click scan key (#6) to select the 
window. If not, return to the Control Panel. Select the General setup. Use the mouse controls to place the cursor 
over the Solitaire window and repeat the above steps. With the game selected and the setup up and running, we 
suggest maximizing the game window. First select the Alt scan key (#10) to reach the menu bar and the Right Arrow 
scan key (#2) to reach the System Menu box . Then use the Down Arrow scan key (#5) to pull down the menu and 
select the Maximize option. Then select the Enter/Deal Card scan key (#1). The solitaire window now fills the 
entire screen with the scanning display positioned at bottom center. You are ready to play the game. 

Tutorial: Use the Enter/Deal Card scan key (#1) to turn over a card from the main deck or from the row stacks. 
This scan key also is used to pick up a card. Use the Left or Right Arrow scan key (#2-3) to move the card to 
another row or stack. Drop the card by selecting the Enter/Deal Card scan key again. To pick up an entire stack, use 
the Left or Right Arrow scan key to move the cursor to the stack. Use the Up Arrow scan key (#4) to move upwards 
to the desired card in the stack. Then use the Enter/Deal Card scan key to pick up the stack beginning at the desired 
card. Use the Left or Right Arrow scan key to move the stack. Then drop the stack by selecting the Enter/Deal Card 
scan key again. The Double Click scan key (#6) to move a card immediately from its place within a stack or open 
deck to the appropriate suit stack. The Double Click scan key also moves an Ace to a suit stack. The Jump/Tab scan 
key (#7) moves quickly to the deck, the suit stacks, or the row stacks. This is especially useful when no more plays 
are to be made and you wish to move quickly to the deck to deal the next card. The Menu scan key (#9) accesses the 
Game Menu. Use the Arrow scan keys to move through the menu and the Enter/Deal Card scan key to select menu 
options. We suggest going to the Control Panel and selecting the General setup to access the Solitaire Help file 
using mouse functions.  

Software: Solitaire (by Wes Cherry)
Publisher: Microsoft Corporation 
Address: One Microsoft Way 
 Redmond, WA 98052 
 
Telephone: 206-882-8080 

Content: Card Game 
Age/Grade: All Ages 
System Requirements: CD ROM, 
 Microsoft Windows, 
 Version 3.0 or higher 
Notes: Game ships with Windows 
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WinSCAN 3.0 Setup #1101 ....................................................... solitare.ws 
 A Typical Solitaire Screen 

 

Design Rationale: WinSCAN 3.0 Setup Screen for Solitaire 
 

 
The solitare.ws WinSCAN setup was designed mainly around the keyboard controls used to play the 
game. The key commands greatly reduce the number of switch activations needed. The user need not 
worry about “overshooting” the mark because the cursor "card selector" is constrained to the cards and 
controlled by the keyboard rather than floating under mouse control. The scan keys were chosen 
for their similarity to actions needed to play the game.  
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WinSCAN 3.0 Setup #3002 ....................................................  livbooks.ws 

  

Software Summary 

An interactive book, Arthur's Teacher Troubles, encourages students to read and explore. The 
book is divided into pages and each page is interactive. The story is read to you by the computer. 
You move through the book by clicking to turn the page. You are encouraged to explore by clicking 
on different objects on the page, causing the objects to make sounds and animate. 

Scanning Display 

 

Startup: Use the General WinSCAN display setup to open the Living Books program. Insure that the mouse 
cursor is over the storybook program window. Select the Control Panel scan key to change setups. Choose the 
Living Books setup (livbooks.ws). Then select quit from the control panel. The storybook program is now 
open with the new scanning display setup running. However the storybook program does not have the focus. 
To re-select the storybook program, insure that the mouse cursor is positioned over the storybook window. If 
so, choose the Left Click scan key (#5) to select the window. If not, use the Mouse Control scan keys (#1-4) to 
move the mouse cursor over the story window and then choose the Left Click scan key. You are ready to work 
the storybook. 

Tutorial: With the story selected and the setup up and running, move through the storybook program exactly 
as you would using the mouse. Maneuver around each story window using the mouse controls (#1-5), clicking 
on objects to animate them. The Page Back and Page Forward scan keys (#6 and #7) are quick ways to move 
from page to page. Choose the Exit key (#8) to go immediately to the title page of the story. 

Design Rationale: The livbooks.ws WinSCAN setup was designed mainly around the mouse functions 
needed to operate the storybook program. The scan keys were chosen for their simplicity and their similarity to 
game features and controls. You may choose to omit the Exit and Control Panel scan keys to prevent the user 
from leaving the program or changing the scan controls inadvertently. 

Notes: ____________________________________________________________________  
______________________________________________________________________________ 
______________________________________________________________________________ 
______________________________________________________________________________ 
  

Software: Arthur's Teacher Troubles
Publisher: Living Books – Random House/ 
 Broderbund 
Address: PO Box 6125 
 Novato, CA 94948 
Telephone: 415-382-4700 

Content: Reading-Interactive Books 
Age/Grade: Elementary 
 
System Requirements: CD ROM, 
 Microsoft Windows, 
 Version 3.0 or higher 
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WinSCAN 3.0 Setup #3002 ....................................................  livbooks.ws 

Typical Arthur's Teacher Troubles Screens 

 

WinSCAN 3.0 Setup Screen for Arthur's Teacher Troubles 
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Picture Icon Suggestions for Common Program Functions 

 
Mouse Left 

 Left Arrow, 
Left, 

Backward 

 
New File 

 
Mouse Right 

 Right Arrow, 
Right, 

Forward 

 
Open File 

 
Mouse Up 

 
Up Arrow 

 
Save, Save File 

 
Mouse Down 

 
Down Arrow 

 
Close File 

 
Left Click 

 
Left Click 

 
ENTER 

 
Right Click 

 
Right Click 

 
Tab 

 
Drag Window 

 Left Double 
Click 

 
Space 

 
Text Window 

 Right Double 
Click 

 
Help 

 Forward, Next 
Page, 

Clockwise 

 
Exit, Quit 

 
Stop 

 Backward, 
Last Page, 
Clockwise 

 
Home 

 
Go 
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Picture Icon Suggestions for Common Program Functions (cont.) 

 Mouse/Cursor 
Left 

 Mouse/Cursor 
Left 

 Undo, Pack, 
Surprise, Open 

 Mouse/Cursor 
Right 

 Mouse/Cursor 
Right 

 
Cut 

 Mouse/Cursor 
Up 

 Mouse/Cursor 
Up 

 Copy, Stamp, 
Save As, Next 

 Mouse/Cursor 
Down 

 Mouse/Cursor 
Down 

 
Paste 

 
Score Board 

 Print, 
Password, 

Clue 

 
Paste, Erase 

 Forward, Next 
Page 

 Exit, Quit, 
Good-Bye 

 
ALT Key 

 Backward, 
Previous Page, 

Go Back 

 Jump, Next, 
Difficulty, Tab 

 
Help Key 

 Pause, ANY 
KEY, Hot 

Key, ENTER 

 
Delete 

 
Home Key 

 Find, Search, 
Magnify 

 
Escape 

 Print Screen, 
Print 

 Find, Unlock, 
Open 

 
Page Up 

 
Page Down 
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Picture Icon Suggestions for Common Program Functions (cont.) 

 Off, Down, 
Sound Off 

 
Internet, 
WWW 

 
Stop, Pause 

 On, Up, Sound 
On 

 Internet, Send 
Mail 

 
Music, Sound 

 New, New 
Player, New 

Game 
 World Wide 

Web, Map 

 
Music, Sound 

 
Open 

 Read Mail, 
Read 

 
Control Panel 

 
Close 

 Send Mail  Control Panel, 
Time 

 
Eject Disk 

 
Menu 

 
Capture, Save 

 
Print 

 Favorite Place, 
Bookmark 

 Deal Cards, 
Play, Enter, 

Select 

 Text Window, 
Type, Print, 

Compose Mail 

 
Yes, OK 

 
Help 

 
Down, No 

 Zoom In, 
Enlarge 

 
Open Window 

 
Up, Yes, Okay 

 Zoom Out, 
Shrink 

 
Close Window 
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Tutorial #3: Using WinSCAN 
to Navigate Windows 

In this chapter, you will practice using WinSCAN to retrieve and run the setup for the Microsoft 
Hearts game that you created and saved in the previous section. First we discuss basic Windows 
navigation techniques and how these considerations affect WinSCAN setup designs. Next, we 
use your setup to select, open, play, and close the Hearts game. The section concludes with a 
short discussion of other ways WinSCAN can be set up to help different users operate different 
software. 

Most application program developers for Windows rely heavily on the basic features of the 
standard Windows Graphical User Interface. This interface is simple to use and in general can be 
accessed entirely either through the mouse or through the keyboard. Most of the time there are at 
least two and often even more different ways to accomplish the same task in Windows. Function 
keys and "shortcut key" combinations, for example, provide rapid access to Windows functions 
and application menus from the keyboard, as do right and left mouse clicks. WinSCAN supports 
most of these methods to the advantage of the single-switch user. 

For basic access to Windows, you need to be able to control the mouse cursor, moving it 
horizontally and vertically to any region of the screen display. You need the Left Mouse Button 
Click function to select objects, pull down menus, and choose menu options. You need the Left 
Mouse Double-Click function or the ENTER key to accept or execute a selected function. The 
TAB key lets you move from one option to another inside dialog boxes. Occasionally you may 
need the SPACE BAR and perhaps the ESCAPE, DELETE, HOME, and PAGE UP and 
PAGE DOWN keys. You may also need the four ARROW keys, one or more of the fifteen 
function keys, or combination keys such as Shift+A, Ctrl+Q, and Alt+F4.19 

For more complete access to Windows, full text entry capability is required, though frequently, 
only short typed messages such as filenames when saving files need to be entered. Since space is 
always at a premium on the Windows graphical desktop, you also need to be able to resize and 
reposition windows at will and to move icons and other objects on the screen. WinSCAN 
provides special scan keys and scanning displays for text editing and for dragging operations. 

In Windows, most of the action occurs near the top or in the center of the screen. The bottom of 
the screen typically is reserved for minimized program icons. Thus a good place for a general 
purpose horizontal WinSCAN scanning display is centered or to the right at the bottom of the 
screen. A good location for a vertical display is at the top or center and to the left of the screen. 

Based on these design considerations, you can create new setups or modify existing ones easily 
to meet specific application or user requirements. From the single-switch user's point of view, 
good setup designs place the functions most often needed most closely at hand. Good setups also 
minimize the number of scan keys - to reduce the area of the display occupied by WinSCAN and 
to minimize the waiting time until the scanning selector reaches the next key needed by the user.  

                                                
19  WinSCAN implements only F1 through F12 and only 2-key combinations. 
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In this context, the WinSCAN special function scan keys are particularly useful. For example, 
the Left Drag key activates a pop-up scanning display for Dragging Left, Right, Up, and Down. 
When no longer needed, these keys disappear from the display. Likewise, in addition to text 
functions, the Text Plus scan key provides pop-up access to mouse controls and many special 
keyboard functions. These also disappear when no longer needed. 

A teacher or a parent may want to design simple and highly specific WinSCAN setups to allow a 
young child to play particular games such as Just Grandma and Me (or another Living Book CD 
from Broderbund/Random House). In such a case, the designer deliberately may wish to omit 
certain functions such as the ability to quit the game to insure that the child won't become 
stranded accidentally back on the Windows desktop. On the other hand, the designer may want 
to create a more complex, but highly flexible setup similar to the General.ws setup shipped with 
WinSCAN for the more advanced single-switch computer user who needs full access to the 
computer. Other design possibilities are compromises such as the Hearts.ws setup created in the 
previous section, perhaps being associated with other general or special purpose setups. 

The Hearts setup is not necessarily the best setup either for playing Hearts or for navigating 
through Windows. However, because it includes both the Control Panel and Text Plus scan keys, 
it can serve both of these purposes and also provide a good tutorial platform for demonstrating 
many useful techniques and features of WinSCAN. 

Step-by-step instructions are provided below to start WinSCAN, load the Hearts setup, and run 
the program. For tutorial purposes, assume your Windows desktop looks similar to the first 
illustration below, with the Hearts subfolder and program icon located inside a folder named 
Microsoft Games.20 

First, a bit of house-keeping. We will begin with the Windows Desktop and assume that a 
shortcut to the General.ws setup file had been placed in the Windows Startup folder. We also 
assume that this General.ws setup included settings to turn AutoStart ON and to use the (same) 
General.ws setup file as the WinSCAN Startup file. Thus, as Windows starts up and presents the 
Desktop, shortly thereafter it will open the General.ws setup file, which is a file of filetype .ws 
which are opened automatically with WinSCAN. With AutoStart ON and General.ws set as the 
Startup setup, WinSCAN will not only open this setup but will also run it automatically, hiding 
the main Setup Window in the process. 

Another assumption is that this General.ws also identifies one or more associated files, 
including for this example a Hearts.ws setup similar to the one you designed in the previous 
Tutorial. Since that setup includes the Control Panel, we will assume it also includes the 
General.ws setup as an associated setup (so the user can return to it after playing Hearts). 

Finally, note that WinSCAN setups occupy display space when they run. Be sure that your 
Desktop is arranged so that these setups do not cover other icons that you may need to access. 

                                                
20  Starting with Windows 8, Microsoft Games were omitted but game apps could be downloaded from the Windows 

Store or from elsewhere on the Internet. WinSCAN works well with these apps or programs in ordinary full screen, 
split window, or normal window modes (but not in the full screen "single-app" mode). Here we assume you have the 
programs on your computer. Instructions may differ slightly for other apps. 



WinSCAN User's Guide 

 53 

These assumptions describe how an experienced WinSCAN user might have his or her computer 
configured for daily independent use. However, alternately, for practice here, it will be fine to 
simply (a) start WinSCAN by clicking on the desktop icon. The Setup Window should appear with 

"Untitled" showing in the title bar. (b) Press the Ctrl+O 
command key combination to open a standard Windows File 
Open dialog box and choose the c:\WinSCAN directory 
(which you created in Tutorial #2) if this is not already 
open and select the setup file named Hearts.ws. (c) 
Click the OPEN button. The File Open dialog box will 
disappear and the Setup Window will display all of the 
general and specific information about the WinSCAN 
Hearts setup you made in the previous section.21 

Alternately, if you are starting with the General.ws 
scanning window running, use the external switch to 
select the Control Panel scan key. This opens the 
Control Panel scanning window. Use the switch to 
select CHANGE TO SETUP = Hearts.ws. Then select 
QUIT. The Hearts.ws setup will run automatically 
immediately. 

Otherwise, if you manually opened the Hearts.ws setup from the WinSCAN File menu, press 
Ctrl+R to run that setup and display its main scanning window. 

Your screen should re-
semble the this illustration. 
The mouse cursor will move 
from now on in increments 
10 pixels horizontally and 
15 pixels vertically relative 
to its initial position. Note 
that on this computer, the 
Hearts.exe program is 
located in a directory folder 
somewhere on the hard disk. 
We could use the Windows 
File Explorer (shown pinned 
to the Task Bar at the 
bottom of the display) to locate that file. However, here, a convenient shortcut icon to open that 
folder has been placed strategically on the Desktop.  

  
                                                
21 Note that possibly you could load Hearts.ws more quickly by selecting it from the list of recently opened setups near 

the bottom of the File menu. Also note whether this setup lists the General.ws setup as an associated setup file. If it 
does not, go to the Settings: Associated Files submenu and add the General.ws setup to the list. Be sure to save the 
Hearts.ws setup after making that change. 



WinSCAN User's Guide 

 54 

From this point on, you can use the external switch to perform all essential Windows functions 
by following a basic strategy: 

(A) To position the mouse cursor over an object or menu option, 
• press the switch when the WinSCAN scanning selector reaches the appropriate mouse 

movement scan key icon 
• hold the switch closed to repeat the function for continuous cursor movement 
• release the switch to stop the cursor and restart the scan 

(B) To click the mouse button to select an object or option, 
• press and release the switch when the Left Click icon is selected 

(C) To activate a selected object or to accept an option's function, 
• press and release the switch when the ENTER icon is selected, or 
• press and release the switch when the Left Double-Click icon is selected, or  

- if neither of these icons is available - 
• press and release the switch when the Text Plus icon is selected 
• use row/column scanning to choose the Ent or Ldc function from the options in the Text 

Plus Window scanning display 
• press and release the switch when the Quit function is selected 

(D) To move rapidly inside dialog boxes from one option box, button, or text field to 
another, 
• press (hold down for repeated function) and release the switch when the TAB icon or 

equivalent Text Plus Window special function is selected, and/or 
• use the Arrow Key icons or equivalent Text Plus Window special functions to choose 

items from subgroups of text fields or radio buttons 

(E) To resize windows or to stretch or drag objects, 
• position the mouse cursor over the object or handle to be dragged 
• press and release the switch when the Drag icon or Drg function is selected 
• press (hold down for repeated function) and release the switch when the appropriate 

direction icon is selected in the Drag scanning display 
• press and release the switch when the Drag Stop icon is selected22 

  

                                                
22  This may take a little patience and practice to accurately position the mouse cursor for dragging or resizing. Be sure 

the window or object to be moved has been selected and given the focus. 
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For example, here is what the screen looked like after we applied these operations to open the 
Microsoft Hearts game. 

First we selected the Text Plus scan key (read more about this important function shortly). Then, 
using the functions provided by the Text Plus scanning window, we moved the mouse cursor to 
hover over the Microsoft Games directory shortcut icon on the Desktop. A Left Double-Click 
opened that folder. We moved the mouse cursor to hover over the Hearts game subdirectory 
listed in the File Explorer. Another Left Double-Click opened that. Finally we moved the mouse 
cursor over the Hearts.exe program icon and used Left Double-Click once more to open and run 
that program. 

 

Next through a series of actions (move the cursor inside the File Explorer window, Left-Click to 
give that window the focus, use the combination Text Plus scan key ALT-ALT to access the File 
Explorer menus, use the f character key to select the File menu, use the down arrow (Da) to 
select the Close option, use the Ent key to activate that option) we closed the File Explorer 
window. Now we need to reposition and enlarge the Hearts game window. 

To do this (since we did not include the Drag scan key in our Hearts setup), select again to the 
Text Plus scan icon. Use the mouse functions to position the mouse curser inside the Hearts 
window title bar. Next select the Drg function. 

At this point, the special Drag Window scanning display pops-up and replaces the normal 
WinSCAN display on the screen as shown above. Note that pop-up displays match the format of 
the normal display. Here the Drag Window uses words rather than icons for scan keys and is 
oriented vertically, as is the normal display. Note that pop-up windows always are positioned so 
that their upper left hand corners are located in the same screen position as the normal window 
they temporarily replace. 
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WinSCAN provides two Drag modes. Unlike the Selection Drag mode, Increment Dragging is 
really a series of drag and drop operations, not a single continuous drag operation, perhaps 
involving several selections. Each time you press and release the switch when a Drag Left, Right, 
Up, or Down icon is selected in the Drag Window, the effect is equivalent to clicking and 
holding the mouse button down; moving the mouse the preset number of pixels left or right or up 
or down (e.g., 10 pixels right or left, 15 pixels up or down, with this setup); and releasing the 
mouse button. If the cursor is not positioned over a draggable object or handle, only the cursor 
moves. If the cursor is over a draggable object (or whenever it reaches one), that object is picked 
up and moved as well. A little practice may be needed to become accustomed to this effect. (The 
Control Panel allows the user to switch Drag modes.) 

One caution: The Increment Drag function does not work in some windows that employ 
"invisible" snap-to grids for dragging. Sometimes an "auto-grid" feature can be turned OFF when 
using WinSCAN in this mode. The Command and Function Reference chapter provides more 
information about dragging. 

The Drag Window looks like this when the 
normal WinSCAN display is horizontal 

and uses picture icons. 

 

After a series of Drag move and resize operations, the screen might look something like this: 
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This is a good point to explore some of the functions provided by WinSCAN's Text Window 
special functions. Press and release the switch when the Text Plus scan key icon is selected to 
pop-up the Text Plus Window scanning display. 

This replaces the normal WinSCAN display on the 
screen. Remember that pop-up windows always are 
positioned so that their upper left hand corners are 
located in the same screen position as the normal 
window they temporarily replace. The Text Plus 
Window display always uses letter abbreviations 
rather than graphic icons as scan keys, but otherwise 
matches the format of the normal display. Here it is 
oriented vertically, as is the normal display and 
employs a column/row scan. When the display is 
oriented horizontally, the scanning pattern is 
row/column. 

 

 

 

The Text Plus Window looks like this and scans by row/column 
when the normal WinSCAN display is positioned horizontally. 

 

 
Two switch activations are needed to select a particular scan key function in a Text Window: the 
first to select the row (or column) containing the function; the second to select the function itself. 
Holding the switch closed after the second activation causes the function to repeat at the preset 
repeat rate. Releasing the switch after the second activation resets the scanning selector to the 
beginning of the scan sequence. 

The Text Plus Window is one of the most powerful special features of WinSCAN. By itself, it 
provides mouse cursor control; clicks, double-clicks and dragging operations; keyboard 
functions such as ENTER, BACKSPACE, DELETE, and SHIFT; full upper and lower case 



WinSCAN User's Guide 

 58 

text entry; function keys such as F1 to F12; and combination keys such as Ctrl+F4.23 The letter 
scan keys from a to z enter lower case text. Selecting the Shf function from the scan causes the 
next letter key selected to be entered as upper case text. Selecting the Cap function toggles the 
keyboard Caps Lock ON and OFF, thus providing a way to enter text in all upper case. When 
entering text, mistakes can be corrected using the Del or Bsp functions, just as these would be 
used from the keyboard. The Arrow Key functions (La, Ra, Ua, Da) operate normally to 
reposition the text cursor. The Ins function toggles the Insert or Overstrike mode for text entry. 
In general, all Text Window functions work exactly the way their corresponding keyboard 
equivalents do in the same situations for the particular software (e.g. a dialog box, word 
processor, spreadsheet, etc.) that you are running. 

The Microsoft Hearts game is played from this point on almost entirely with mouse functions 
and mouse clicks. The Score Board can be summoned at any time by selecting the Score Board 
scan key (which sends the F4 function keystroke to the application). When the user is finished 
playing, he or she can double-click on the System Menu box in the left corner of the Hearts 
window title bar to close the game, return to the Desktop, and select another program. If your 
Hearts setup is associated with other setups, you can link to one of these using the Control Panel 
scan key and window options. 

Enjoy using WinSCAN and your single-switch 
to play Microsoft Hearts! 

This tutorial has taken you through most of the basics of using WinSCAN to navigate Windows 
and operate specific application programs. Advanced topics (such as using the AutoStart feature) 
and more detailed explanations of program features are discussed in the Command and Function 
Reference chapter of this guide. 

WinSCAN can also be used as an ordinary single-function, single-switch interface for games, 
educational activities, and other software that have scanning selector features built-in.24 Create a 
setup containing one function (e.g., the ENTER key, Spacebar, or a mouse click, etc.) 
depending upon how the software program you plan to use is controlled. We suggest positioning 
this setup scanning display at the Bottom, Aligned Right corner of the display and setting the 
Repeat Rate to a long delay, e.g. 2 seconds or longer. To return to the main Setup Window, select 
the WinSCAN scanning window to give it the focus as usual and press the ESCAPE key. 

  

                                                
23 The Shf, Ctl, Fn, and Alt scan keys begin combination key commands such as Shf-A (to send a capital A) or 

Ctrl+X.  The Text Plus Window title bar changes to indicate one of these keys has been pressed. To send the ALT 
key by itself, use the Alt+Alt combination scan key sequence. To change the focus, use Alt+Esc. To send a right-
click or right-double click, use Shf+Lc or Shf+Ldc. Combination keys do not repeat. 

24  SS-ACCESS for Windows from Academic Software, Inc. is an example of a single-function, single-switch interface 
which also uses the SS-ACCESS USB Adapter to connect to the external switch. Dino-GAMES and Multi-SCAN 
from ASI are examples of software featuring built-in scanning, as are many other titles - especially for young or 
developmentally young children - from other vendors. 
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Another point to remember is how to quit WinSCAN. Whenever one of the pop-up windows is 
selected and has the focus, pressing the ESCAPE key on the keyboard will close the window, 
just as selecting the Drag Stop or Quit function using the scan and the switch closes the 
respective window. Likewise, when the WinSCAN main scanning display itself is selected and 
has the focus, pressing the ESCAPE key will close the main WinSCAN display and return to the 
Setup Window. 

Going Beyond the Basics: At this point, to familiarize yourself more thoroughly with 
WinSCAN, we suggest that you return to the Setup Window. Open the General.ws setup that 
ships with WinSCAN. Following Steps 27-29 in Chapter 3: Tutorial #1, associate your new 
Hearts.ws setup file with the General setup. Save the modified General setup. Recall your 
Hearts setup. Again following Steps 27-29 in Chapter 3, associate it with the General.ws setup 
file. Add the Control Panel scan key in position #9 (if it is not already there). Save your 
modified Hearts setup. Then practice using these two linked setups to navigate Windows and 
play Hearts or other similar software. 

Next, begin to design some custom WinSCAN control display setups for software that you are 
familiar with. Follow the guidelines provided at the end of Chapter 4: Tutorial #2. For example, 
Just Grandma and Me, Arthur's Teacher Troubles, and other Living Books on CD-ROM from 
Broderbund Software and Random House can be made completely accessible to children with 
disabilities using simple WinSCAN setups, as can e-book programs such as the Kindle Reader 
from Amazon.com or the Nook Reader from BarnesandNoble.com. For a person who can use a 
trackball to position the mouse cursor but can not access the mouse buttons, design a WinSCAN 
setup containing only four scan keys (Left Click, Double Click, Left Drag, and Text Plus). For an 
adult who needs access to programs like Microsoft Word or Internet Explorer, modify the 
General.ws setup or create a new associated setup made entirely of the most frequently needed 
command keys and special functions, letting the pop-up Text Plus Window provide all or most of 
the basic control access functions needed for word-processing. For a person with cerebral palsy 
who can use a switch, experiment with the dwell setting to allow sufficient time for the user to 
refocus attention on the display screen before the computer allows the selected action to take 
place. 

Academic Software, Inc., plans to continue to improve the power and flexibility of WinSCAN in 
coming years, but we believe you will find the version you have right now to be one of the most 
versatile control interfaces for single-switch users on the market today. 
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WinSCAN 
Command and Function Reference 

 

This section provides details and technical information about each window, menu, and dialog 
box you will encounter when working with WinSCAN. As a program, WinSCAN uses a single 
document interface. Therefore, only one setup file can be open at a time. Also, only one copy of 
WinSCAN itself can run on the computer at a time. When the program first starts (and the 
AutoStart feature is OFF), it displays the Setup Window. This is where WinSCAN scanning 
displays are created or recalled, designed or edited, and saved or printed. These operations 
require full use of the keyboard and mouse and can not be performed under single-switch 
control.25 Once a particular setup has been created or loaded, it is run by choosing the Run option 
from the Setup Window's File menu. When a setup is running, the Setup Window disappears and 
the WinSCAN scanning display window appears on the desktop. From this point on, the external 
switch is active and the switch user has control. 

The discussion below first explains what happens when the WinSCAN program starts. Next, 
each menu, menu option, and dialog box function used when working with WinSCAN setups is 
described. The section concludes with a description and discussion of the main scanning display 
window and the special function pop-up displays for dragging, text entry, and user control. 

The Setup Window 

When WinSCAN first starts, it displays an "untitled" Setup Window, as shown on the next page. 
This is a standard window that can be resized, repositioned, minimized, covered, or closed like 
any other application program window. The Setup Window title bar indicates that the name of 
this setup is Untitled because it has not yet been saved under a particular name. The display 
shows all of the default general settings and indicates that all of the twenty scan key positions are 
defined currently as EMPTY. Once the setup is saved or whenever an existing setup file is 
opened, the title bar will indicate the setup name and the display will show all of the current 
general setting information and scan key definitions for that particular setup. 

  

                                                
25  Future updates of WinSCAN may include a WSUtility program that can be run along side WinSCAN to create and/or 

edit setup files using WinSCAN itself. Check the Academic Software, Inc. website http://www.acsw.com 
periodically for announcements and downloadable setups and utility programs. 
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GENERAL SETTINGS defaults include: 

• using both the external switch connected through the SS-ACCESS USB Adapter and a 
keyboard "hot-key" (the tilde ~ key is the default) to control the scanning display 

• audible scanning prompt (NONE or OFF) 
• the speed of movement for the scanning selector (1 second per step) 
• the key repeat rate when the external switch or the hot-key is held pressed (0.25 second) 
• dwell response (activation delay) (0 seconds or OFF) 
• autostart (OFF) with no startup file identified 
• no other setup files associated with this new untitled setup 
• the default increments for horizontal and vertical mouse movements 

(10 pixels horizontal, 15 pixels vertical, per step) 
• the default setting for the drag style (increment) 
• an initial scan design (1 row and 1 column), centered at the bottom of the display screen, 

using normal size word rather than picture scan key icons, with a red selector box running in 
the horizontal scanning mode 
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SPECIFIC SETTINGS for each position from 1 to 20 (left to right from top to bottom) in the 
scanning display include: (1) the number identifying the particular picture icon to be displayed in 
that position selected to represent the function or command; (2) the particular mouse function, 
key command, or WinSCAN special function associated with that position; and (3) the particular 
word or phrase assigned to describe that function or command. Up to twenty scan positions can 
be defined. Initially all of these positions are "NULL" and "EMPTY" by default. Normally the 
first thing to do at this point is load a previously defined setup or create and save a new one. 

When the WinSCAN application program starts, the Windows operating system checks for the 
existence of an initialization file called winscan.ini in the application directory. If this file is not 
found, WinSCAN creates it. The winscan.ini file retains the last screen location of the Setup 
Window and the list of up to six most recently opened WinSCAN setup files which appears near 
the bottom of the Setup Window File Menu. Selecting one of these "most recent file" options is a 
quick way to open a WinSCAN setup file. 

When WinSCAN starts, the program also scans for the presence of the SS-ACCESS USB 
Adapter and for the presence of an external single-switch (the presence of a phone plug, actually) 
plugged into the interface adapter. If the interface hardware is not found, a message prompt 
appears in the middle of the Setup Window to alert the user. The SS-ACCESS information field 
shown in the Setup Window indicates "Off-Line." If there appears to be no switch plugged in, 
this field indicates "On-Line-No Switch." Otherwise, this field indicates "On-Line." For an 
immediate test of switch action, pressing the external switch should toggle the WinSCAN "Hello 
User" welcome graphic at the lower left of the scanning window. Clicking on this picture with 
will also toggle the graphic displayed. 

An attempt to run a WinSCAN setup file that includes mouse function scan keys when the 
Windows mouse driver has not been installed (e.g., because the mouse was not plugged in when 
Windows started up) may present problems. Setups with mouse function scan keys, including the 
Text Edit special function window, will run in this situation but the mouse function scan keys 
may not work. This is seldom a problem, especially for laptop PCs. 

Attempts to quit WinSCAN or to create or load a new setup following changes to the current 
setup still in memory cause the program to prompt the user about whether or not to save the 
changes before continuing. 

The information displayed in the General Settings and scan key Position Information datagrid 
areas of the Setup Window updates dynamically as the user makes and accepts changes in the 
dialog boxes associated with the various setting controls. This makes it easy to see at a glance 
how the scanning display will appear and how the scan keys will be arranged and defined. When 
the Print or Save option is selected from the File menu, this is the information that is printed or 
saved. When the Run option is selected, the Setup Window disappears and the scanning display 
window opens. The WinSCAN program and data remain always in memory, however, and the 
user can return easily to the Setup Window (by pressing the ESCAPE key when the scanning 
display has the focus) for further modification to the current setup design. 
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The FILE Menu 

The File Menu is used to create, load, save, print, and run 
WinSCAN setup files. A setup file contains all of the general 
setting information and all of the scan key definition information 
needed to recreate and run a WinSCAN scanning display. If a new 
setup file has been created or current setting information has been 
changed, WinSCAN will ask the user whether the current setup 
information should be saved before the program quits or before 
another setup is created or opened. Each File Menu option is 
discussed in detail below. Use Alt-F as a keyboard shortcut.  

 

Run  _____________________________________________________ (shortcut key: Ctrl+R) 

The Run option closes the Picture Choices window (if it was open), causes the Setup Window to 
disappear, and opens the currently loaded WinSCAN setup as the main scanning display window 
in the appropriate location and configuration on the Windows desktop. Note that Run does not 
save setup data nor does it actually close WinSCAN. Several prompts may appear when the Run 
option is selected. For example, if no scan key has been defined, a message will inform the user 
that there is no setup to run. If only one scan key is defined, WinSCAN becomes a standard 
single-function switch interface, suitable for controlling certain software packages, particularly 
those for children, with built-in scanning features. Dino-GAMES and Multi-SCAN from 
Academic Software, Inc. are examples of such software. 

New  ______________________________________________________ (shortcut key: Ctrl+N) 

The New option resets all general setting information and scan key definitions to default values. 
The name of the current setup in the Setup Window title bar changes to "Untitled." If current 
setup information has changed and not been saved before choosing the New option, a prompt 
message asks whether to save the current setup before resetting. 

Open...  ____________________________________________________ (shortcut key: Ctrl+O) 

The Open... option is 
used to retrieve a 
WinSCAN setup file 
that has been saved 
previously on disk. 
Selecting Open... 
brings up a standard 
Windows File Open 
dialog box as shown 
here, asking the user 
to select the drive, 
directory, and file-
name to be opened. 
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WinSCAN setup filenames always should end in the suffix .ws. By default, the File Open dialog 
box displays only those files in the current directory ending in this suffix. If current setup 
information has changed and not been saved before choosing the Open... option, a prompt 
message will ask whether to save the current setup before opening another one. 

Save  ______________________________________________________ (shortcut key: Ctrl+S) 

The Save option is used to save the current setup information on disk as a WinSCAN setup file. 
Selecting Save will save the current setup information immediately, replacing any previously 
saved version of the setup file on disk. If a new setup has been created but never saved, selecting 
the Save option is the same as selecting the Save As... option described below. 

Save As...  _______________________________________________________(no shortcut key) 

The Save As... option is 
saves the current setup 
information on disk as a 
WinSCAN setup file under 
a possibly different file-
name. Selecting Save As... 
brings up a standard 
Windows File Save As 
dialog box, asking the user 
to select the drive, 
directory, and filename for 
saving. WinSCAN setup 
filenames always should 

end in the suffix .ws. By default, the File Save As dialog box displays only those files in the 
current directory ending in this suffix. When the user types a setup name in the File Name field, 
if the suffix is not typed, it will be added to the filename automatically when the file is saved. If 
the new filename matches an existing filename, the File Save As dialog box will prompt the user 
before overwriting the old file. 

Print...  ____________________________________________________ (shortcut key: Ctrl+P) 

The Print... option sends a picture of the WinSCAN 
Setup Window to a printer. It may be necessary to 
scroll or enlarge the window to view and print all of 
the scan key definition information comprising the 
setup. Selecting Print... opens a standard Windows 
Print dialog box. Pressing the ENTER key or 
clicking on the OK button sends the report to the 
designated printer and closes the dialog box. Clicking 
on the Cancel button or tabbing to that button field 
and pressing ENTER closes the Print dialog without 
sending the report. 
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Recent Files  _____________________________________________________(no shortcut key) 

When WinSCAN starts, the Windows 
operating system checks for the existence 
of an initialization file called winscan.ini 
in the directory where the WinSCAN 
CS.exe program is installed. If this file is 
not found, Windows creates it. The 
winscan.ini file contains the list of up to 
six most recently opened WinSCAN setup 
files. This list appears near the bottom of 
the File menu. Selecting one of these 
"most recent file" options is the quickest 
way to open a WinSCAN setup file. If 

current setup information has changed and not been saved, a prompt message will ask whether to 
save the current setup before opening another one. 

Quit  ______________________________________________________ (shortcut key: Ctrl+Q) 

The Quit option closes all WinSCAN windows and terminates the program. If current setup 
information has changed and not been saved, a prompt message will ask whether to save the 
current setup before quitting. There are a number of other ways to quit an application program. 
Double-clicking on the System Menu box (the small WinSCAN icon at the left in the Setup 
Window title bar) will terminate WinSCAN immediately, as will selecting the Close option from 
the System Menu box itself or by clicking on the WinSCAN program icon in the Windows Task 
Bar and selecting the Quit option . You can also click on the Close box marked with an "X" at 
the right end of the Setup Window title bar. 
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The SETTINGS Menu 

The Settings menu is used to set or change each of the general 
WinSCAN scanning display window settings. Selecting and 
changing any of these menu or submenu options immediately 
updates the information that is displayed in the Setup Window. 
Use Alt-S as a keyboard shortcut. 

 
 Scanning Display 
 with Words and Phrases 

 
 Scanning Display 
 with Picture Icons  

Word Window or Picture Window   _____________________________  (shortcut key: Ctrl+W) 

These two options determine whether the scanning display will use words and phrases or picture 
icons to represent command functions associated with scan key definitions. The currently 
selected option has a check mark ✓ beside it in the menu. Selecting the unchecked option 
changes this setting. The illustrations above left demonstrate how a scanning display setup would 
appear with either the Word Window or Picture Window option selected. 

Increment Drag or Selection Drag  _______________________________ (shortcut key: Ctrl+I) 

This Settings menu option determines whether WinSCAN will use increment or selection 
dragging when the special function Drag Window is displayed. This option is discussed later in 
this chapter in the section describing the special function scan keys. 

Tone Submenu  __________________________________ (shortcut keys: Alt+S followed by T) 

The Tone submenu determines whether an audible tone is heard through the 
PC speaker either (1) each time the scanning display steps to a new scan key 
position (Scanning) or (2) each time the user presses the external switch 
(Response). When an audible prompt is active, one of these Tone options 

has a check mark beside it in the submenu. Otherwise the None option is checked. Selecting one 
of the unchecked submenu options changes the Tone setting. Note that the prompt sound volume 
is controlled by Windows Volume Control settings. 
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Switch Control  ___________________________________________________(no shortcut key) 

If the SS-ACCESS information field (the first information item shown in the main Setup Window) 
displays On-Line, then the SS-ACCESS USB Adapter has been found with a device (the switch) 
plugged in. In this case, the external switch is always active. The Switch Control submenu allows 
the user to select a keyboard hot-key that will also act as a "switch key" when pressed. If the SS-
ACCESS USB option is checked, then there is no hot-key. But if Hotkey is checked, one of three 
options can be selected (the Tilde Key (~), the Spacebar, or the F11 key).26 Pressing the hot-key 
using the keyboard when WinSCAN scanning displays are running will have the same effect as 
pressing the external switch. 

If WinSCAN was unable to locate the switch interface, the message "Off-Line" appears. If the 
adapter is found but a switch is not plugged in, the message is "On-Line, No Switch." In either 
case (on startup and if the switch or the adapter becomes unplugged while WinSCAN is 
running), a WARNING message box also appears with instructions to check your connections. 
While the Setup Window is displayed, press the external switch to test switch action. The Welcome 
icon to the lower left of the window should change each time the switch is activated. 

Scan Options Submenu  ____________________________ (shortcut keys: Alt+S followed by S) 

The Scan Options submenu controls six important parameters that determine the behavior of the 
scanning selector and the organization and initial placement of the main WinSCAN scanning 
display window. These include: 

•  the scan speed - e.g., the speed of 
the moving selection rectangle in 
the display 

• the scan mode - e.g., horizontal or 
vertical linear scanning or row/ 
column or column/row sequential 
scanning 

• the display design - e.g., # of rows 
and columns of scan key positions 

• the display placement - at top, 
bottom, or center; to the left, right, 
or centered on the screen 

 

• the size of scan icons - e.g., small, normal, or large 

• the color of the scanning selector rectangle  

                                                
26  A fourth Hotkey sub-option "Custom" is not currently implemented. However, future upgrades may allow the user to 

select other keyboard keys to become the "hot-key." Note: Beware that choosing a hot-key prevents that particular 
key from being sent to an active Windows application when using the main Scanning Window. However,  the Text or 
Text Plus special function windows operate normally. 
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Scan Speed...  __________________________________________ (shortcut key: Ctrl+Shift+R) 

The Scan Speed... option controls how 
quickly the scanning selector in 
WinSCAN scanning display windows 
moves from one scan key (or one row or 
column of scan keys) to the next. The 
Scan Speed dialog box provides choices 
ranging from .5, .75, 1, up to 10 seconds 
delay per scan step. Choose the Default 
button to set the scan speed to the rate of 

1.0 second per step and close the dialog. Select a radio button to choose a different scan speed 
and click the OK button to accept that value and close the dialog. Click the Cancel button to 
close the dialog without changing the scan speed. 

Scan Mode  ______________________________________________________(no shortcut key) 

The Scan Mode submenu determines the 
movement pattern followed by the 
scanning selector. Choices include linear 
scans (stepping and highlighting one scan 
key position at a time horizontally or 
vertically) or sequential scans (first 
stepping and highlighting one entire row or 
column at a time, then moving linearly 
across or down that row or column). The 
currently selected option has a check mark 
✓ beside it. 
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Scan Design...  _________________________________________ (shortcut key: Ctrl+Shift+D) 

This option determines how the 
sequence of scan keys are displayed, left 
to right and top to bottom, in rows and 
columns. It is best to wait until all of the 
scan key positions in a setup have been 
defined before changing this option. At 
runtime, WinSCAN will automatically 
adjust the number of rows and columns 
to fit the number of scan key positions 
that have been defined, if current 
settings are exceeded. You may need to 
check these results again if the scanning 
display is not what you expect. 

The maximum useful number of scan key positions (up to 20) depends upon several factors, 
including your screen resolution, the icon size selection, and number of rows and/or columns. 

To change the Scan Design..., enter numbers between 0 and 20 in the Rows: and Columns: data 
fields in the dialog box. Note that the product of rows times columns can not exceed 20 icons. A 
horizontal pattern of scan keys results when there are more columns than rows. A vertical 
arrangement results when there are more rows than columns. The illustrations on page 1 provide 
examples of these two display styles. Click the OK button to accept the new design and close the 
dialog. Click the Cancel button to close the dialog without changing the current configuration. 
Run WinSCAN using the File Menu Run option or the Ctrl+R shortcut key to observe the effect 
on the scanning display. Press ESCAPE to return to the Settings Window for further design 
modification. 

 

 

  

IMPORTANT NOTE: It is important to realize that the Scan Design... 
option also interacts with the Scan Mode... option. For example, if the 
number of rows and columns is reversed, the scan mode must also be 
changed - e.g., from horizontal to vertical - to maintain the scan key order 
while rotating the display 900. This is accomplished by clicking the 
Transpose Rows & Columns & Scan Modes button. It is a good idea to 
create your setup first by laying out the rows and columns for a normal 
horizontal scan. Once that is satisfactory, return to this dialog box and 
click Transpose to automatically orient it correctly as a vertical scan. 
Click the SAVE button to accept the new design and close the dialog box. 
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Scan Placement  __________________________________________________(no shortcut key) 

The Scan Placement submenu options 
determine the position of the WinSCAN 
scanning display window when it 
appears on the screen. The Scan 
Window Placement submenu must be 
opened twice. First, click the placement 
choice – e.g., vertically, at the top or 
bottom or at the center of the display 
screen. Second, click the alignment 
choice – e.g., aligned horizontally at the 
left or right edge or at center of the 
display screen. Check marks ✓ appear 
beside each current choice. 

Icon Size  _______________________________________________________(no shortcut key) 

The Icon Size submenu provides options to display Small, Normal, or Large icon scan keys in 
the main Scanning Window. This feature may be particularly useful for visually impaired users. 
However, choosing large icons may limit the number of icons that can be displayed horizontally 
or vertically in the Scanning Window. On the other hand, small icons may be difficult for users to 
see and recognize easily. These considerations also depend upon the screen resolution and other 
factors. 

Scan Box Color  __________________________________________________(no shortcut key) 

The Scan Box Color submenu allows you to choose a color for the WinSCAN scanning selector 
rectangle that is easy for the user to see. Options include Red (the default), Blue, Yellow, Green, 
or Custom. Choosing Custom opens a standard Windows Color Picker dialog box offering a full 
range of custom color choices. 

  



WinSCAN User's Guide 

 71 

Switch Repeat Rate... ______________________________________________(no shortcut key) 

The Switch Repeat Rate... affects 
WinSCAN functions such as mouse 
cursor movement, dragging, and 
keystroke entry which continue by 
repeating as long as the user holds the 
external switch closed. The repeat rate 
can be set to be the "same as the scan 
speed" or it can be adjusted inde-
pendently. Options include repeat rates  

of .1, .25, .5, 1, 1.5, 2, and 2.5 seconds. The repeat rate also can be set "as fast as possible" 
(which means on most computers, about five repeats per second). Choose the repeat rate by 
selecting one of the radio buttons in the dialog box. Click the OK button to accept the new rate 
and close the dialog. Click the Default button to restore the default repeat rate and close the 
dialog. Click the Cancel button to close the dialog without changing the repeat rate. 

Dwell Response...  ________________________________________________(no shortcut key) 

The Dwell Response dialog box 
determines the activation delay time 
between the moment the user presses 
and releases the external switch and the 
moment when WinSCAN actually sends 
the selected scan key command to 
Windows and, hence, to the running 
application program (which has the 
focus). This feature is designed to 
provide the user a sufficient delay time 

to shift his or her focus of attention from the scanning display to the area of the computer screen 
where the action resulting from the command takes place. Dwell Response options include no 
activation delay at all (0 or None is the default) or .25, .5, 1, 2, or 3 seconds delay between 
activation and action. Choose one of the radio buttons in the dialog box to change the setting. 
Click the OK button the accept the new settings and close the dialog. Click the Default button to 
reset the dwell time to None and close the dialog. Click the Cancel button to close the dialog 
without changing the current dwell setting. 

Note that the Dwell Response also occurs after (and in addition to) each switch or hot-key Repeat 
cycle if the switch or hot-key is held pressed down. If the Repeat Rate is slow and the Dwell 
Response is long, then it can take quite a while before the scanning selector advances to the next 
scan key. 
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AutoStart  __________________________________________________ (shortcut key: Ctrl+A) 
The AutoStart… option is one of the most important features of WinSCAN from the point-of-
view of fully independent computer access. This option controls WinSCAN's ability to skip the 
Setup Window on startup and go immediately into the scanning display mode (or load a 
previously identified setup file and do so) without operator intervention. Selecting AutoStart 
opens the AutoStart dialog box shown below. To activate this feature, select the radio button 
labeled Yes in the frame with the question, "Should WinSCAN autostart the selected Startup Setup 
file?" To deactivate this feature, select the radio button labeled No. This is the default setting. 

 
If AutoStart is activated, a setup will run immediately when opened. Alternately, you can give 
WinSCAN the pathname to another setup file that it should load (and run, if AutoStart is ON) at 
startup. For example, if you performed the recommended WinSCAN installation, you may wish 
to choose the General.ws setup. In that case, open that setup, go to this dialog box, click the 
YES button, click OK, and save the file. To select a different StartUp Setup file, click the "... 
identify the Startup Setup file … " field. A standard Windows Open File dialog box will appear. 
Choose the drive and directory that contains your setup files (typically c:\WinSCAN). Select the 
setup file you want and click OPEN. The full pathname to this file will appear in the AutoStart 
filename field. Repeat this procedure to select a different StartUp Setup file or click the CLEAR 
button to void the field entry. Click the OK button to accept any changes made and close the 
dialog box. Click the Cancel button to ignore any changes and close the dialog. The current 
AutoStart settings are displayed in the General Settings section of the Setup Window. 
AutoStart is a setup parameter, not a WinSCAN parameter. To implement the AutoStart feature 
fully, so that WinSCAN will start up and automatically run a setup when Windows starts or re-
starts, you must place a shortcut to a setup file that has the AutoStart feature activated and either 
is or points to the startup setup you want to run into the Windows Startup directory. 
For example, any setup that has been saved can be a WinSCAN Startup Setup. So the 
General.ws setup file can have AutoStart turned ON (or another setup file with AutoStart ON 
that also points to it) be the designated Startup Setup file. WinSCAN should be the default 
program for running files of filetype .ws. If a shortcut to the General.ws file is in the Windows 
Startup directory, then whenever you start or restart your computer, Windows will load, run, and 
shortly begin by loading and running all the items in the Startup directory, including General.ws 
via the shortcut. WinSCAN will load, open General.ws, open it or another AutoStart setup file 
automatically and go immediately into the scanning display mode without operator intervention. 
This process provides the single-switch user fully independent initial access to the computer.  
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Associated Files ...  ________________________________________________(no shortcut key) 

 

The Associated Files... option is an advanced feature of WinSCAN to enhance fully independent 
computer access. The Associated Files ... dialog box shown above allows the setup designer to 
identify up to five other previously defined and saved WinSCAN setup files - customized, for 
instance, for particular games or applications - that will be associated with the current setup file 
being created or edited. This feature works together with the Control Panel special function scan 
key to allow the single-switch user to modify WinSCAN options and link to a different setup 
from the one that is currently running. If the user selects a new setup file, that setup loads and 
runs immediately when the user quits the Control Panel. If the newly loaded scanning display 
setup also includes the Control Panel scan key and if the new setup was defined as associated or 
linked to the previous setup, then the user can move back and forth among these and other linked 
setups in any pattern. 

To create a link to an associated setup file, you must give WinSCAN the complete pathname to 
reach that file. For example, in addition to the General.ws setup, another setup file (one for the 
Microsoft Solitaire card game) is shipped with WinSCAN. If you performed the recommended 
WinSCAN installation, you may wish to click on the File 1 field and locate the 
c:\WinSCAN\Solitare.ws setup file using the Open File dialog box. Associate other setup files in a 
similar fashion by clicking the File 2, File 3, or other fields as well.27 Click the OK button to 
accept the new settings or click the Cancel button to ignore them. This closes the Associated 
Files... dialog. Now is a good time to use Ctrl+S to save your work. 

The next step is to make sure that the Control Panel scan key is defined in one of the scan 
positions in the current setup so that it will appear in the scanning display when this WinSCAN 
setup runs. If the user presses the external switch when the Control Panel scan key is selected, 
the Control Window opens. This window provides a secondary scanning display that allows the 
user to select or change many WinSCAN program options. One set of these options is the list of 
associated setup files. 

  
                                                
27  Should these files be moved or deleted later on, when the Control Panel opens, WinSCAN will ignore the request to 

link to an associated file that no longer exists. 
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If the user selects a new setup file from the list, that setup loads and runs immediately as soon as 
the user quits the Control Panel.28 If the newly loaded scanning display setup also includes the 
Control Panel scan key and if the new setup itself was defined as being associated or linked to 
the previous setup, then the user can move back and forth in any pattern among these and any 
other similarly linked setups. 
Since each setup allows up to 20 scan key functions, including the text windows and other 
special functions, Associated Files... gives the single-switch user access to up to 120 different 
scan keys arranged in up to 6 groups (i.e., the scanning display setup that is running currently, 
plus 5 more setups linked to it). Even deeper hierarchies can be constructed. For example, one 
setup for general purpose Windows navigation (such as General.ws or Basic.ws) can be linked 
to 5 other setups designed for specific programs (e.g., Web browsers, multimedia packages, or 
games) each of which possibly linked to up to 5 other setups for subsections within programs or 
sets of seldom used but occasionally needed command functions. 
Custom setups typically are more efficient ways to access specific programs than are general 
purpose setups. This is because the more scan positions there are that are not needed, the more 
time it takes to access those functions that are required frequently. 

  

                                                
28  If you have made changes to the current setup in the Settings Window, make sure the current setup is saved before 

testing this feature. Otherwise, since there is no warning to save changes before switching setups in the Control 
Panel, any such changes would be lost. 

IMPORTANT NOTE: When WinSCAN runs its first setup, the main 
scanning display - not the application program window - is initially 
always highlighted and has the initial focus. Also, when the very first 
setup is run, WinSCAN will automatically center the mouse cursor on the 
screen. It is always a good idea at this point to position the mouse over the 
Desktop (if it is over another window) and perform a Left Mouse Click or 
Double-Click. This will take the focus away from the main scanning 
window, any special function windows that may open later, and any 
associated setups that you may link to later. 

Likewise, it is a good idea to (1) open an application program, (2) 
reposition it if need be, (3) position the mouse cursor over the application 
window, and (4) Left-Click to give that application the focus before (5) 
linking to an associated setup designed specially for that program. 
Following the link, if the focus has shifted, use a mouse click scan key or 
the Alt+Esc command key combination (defined as a scan key or 
available through the Text Plus Window) to give the application window 
the focus. Following this routine procedure will mostly avoid the unlikely 
situation where the scanning windows have the focus, rather than the 
application you want to control. 
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Mouse Jump ...  ______________________________________________ (shortcut key: Ctrl+J) 

The Mouse Jump... distance in pixels is 
how far the mouse cursor will move 
when the user selects mouse movement 
functions (Mouse Left, Mouse Right, 
Mouse Up, Mouse Down, and Left 
Drag) using the WinSCAN scanning 
display. The dialog box provides data 
fields for entering distances for 
horizontal and vertical travel 
independently. Values can be set from 1 
to 400 pixels per jump. (The defaults 
are 10 pixels horizontal and 15 pixels 
vertical per move.) Mouse movements 
continue at the "repeat rate" speed setting as long as the user holds the external switch or hot-key 
closed. Smaller increments give better control but require more time to move a given distance. 

To preview how the mouse will behave before leaving the dialog box, click on the Test Left, 
Test Up, etc., buttons (followed by the ENTER key to repeat) and observe the movement of the 
mouse cursor. The Default button resets the jump values to 10 pixels right or left and 15 pixels 
up or down. Click the OK button to accept the movement settings and close the Mouse Jump... 
dialog box or click the Cancel button to close the dialog without changing the current settings. 

 

 

  

WinSCAN also offers precision mouse cursor control for movement and 
dragging operations. If the Control Panel special function scan key is 
included in the main scanning display, it provides a quick option to adjust the 
horizontal and/or vertical Mouse Jump distance to move the cursor only one 
pixel left, right, up, or down. This distance can similarly be reset to normal 
movement just as quickly if desired. 

For precision dragging operations, the Drag Window set of special functions 
includes a Trim scan key that acts as a toggle when selected, switching from 
the "Big Jump" mode corresponding to the preset Mouse Jump... distances to 
a "Little Jump" mode that temporarily changes the Mouse Jump... presets to 
one pixel in each direction. The "Little Jump" mode lasts until the Trim scan 
key is reselected or until the Drag Window is closed. 
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The SCAN KEYS Menu 

The Scan Keys Menu is used to (1) create or 
edit WinSCAN scanning display scan key 
position definitions, (2) rearrange the order in 
which scan keys are listed in the Setup 
Window and appear in the scanning display, 
and (3) view sets of picture icons that may 
serve as scan keys and represent control 
functions in such displays. These options are 
discussed in reverse order below. Use Alt-K as a keyboard shortcut. 

View Pictures...  ____________________________________________ (shortcut key: Ctrl+V) 

The View Pictures option provides visual access to the small built-in library of picture icons used 
when designing WinSCAN scanning display setups. Selecting this menu option opens or closes 
the Picture Choices window. This window can be resized and repositioned anywhere on the 
screen, where it can be seen while creating or editing a setup. 

Click inside the Picture Choices window to toggle from one icon screen to the next. To close the 
window, press Ctrl+V again or double-click the System Menu box (left) or the Close box (right) 
in the Picture Choices title bar. Running a WinSCAN display setup (by selecting Run from the 
File menu or pressing the Ctrl+R shortcut key) or quitting WinSCAN (by selecting Quit from 
the File menu) also closes the Picture Choices window automatically. 

The Picture Choices window presents a useful subset of 90 picture icons (viewed 30 at a time), 
many of which were selected from the KeyPics picture library published by Academic Software, 
Inc. KeyPics is a library originally designed for constructing picture overlays for persons with 
disabilities who rely on alternate keyboards to provide computer access and to control games and 
other application software. 

Sixteen icons (the mice, arrows, hands, and faces) are preset to be used to represent mouse 
movement directions and ARROW key functions. Several icons represent clicking or double-
clicking the left or right mouse button. Other special icons elicit special scanning displays for 
dragging functions, text entry, and the control panel. Eleven labeled key icons represent 
ENTER, TAB, SPACE BAR, and other commonly needed key commands. There are general 
purpose icons to represent common game control functions like STOP and GO and HOME and 
JUMP and multimedia functions like FORWARD and BACKWARD and LAST PAGE and 
NEXT PAGE. 
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Other icons stand for functions 
needed to access the Internet and 
work with e-mail. Finally, there are 
several general purpose graphics to 
stand for other functions one might 
need to operate a particular 
program: e.g., the "PAWS" icon 
could represent functions such as 
"pause" or "help." 

The Picture Choices window is for 
viewing only. You do not click on 
these icons to select them. Instead 
each icon is numbered. However, 
this window can be moved to a 
convenient location where you can 
see it easily while creating your 
setup. 
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Edit Positions Submenu  ______________________________________ (shortcut key: Ctrl+E) 

Once a group of scan keys is 
defined, the Edit Positions... 
submenu provides options for 
rearranging the scanning 
display by inserting, moving, 
switching, or deleting scan 
key definitions listed in the 
main WinSCAN Setup 
Window. 

The illustration on the right shows a full view of the Setup Window datagrid for the General.ws 
setup file that comes with 
WinSCAN opened. The Scan 
Position column indicates the order 
in which the scan keys will appear 
when this setup runs as a scanning 
display. The other four columns 
comprise each scan key definition, 
identifying the picture number and 
icon representing the scan key in 
the Picture Window mode, the word 
or phrase representing the scan key 
in the Word Window mode, and the 
control function that the key will 
perform when it is selected by the 
scan and the user presses the 
external switch. 

Initially, scan keys appear in the list 
in the order that they are created 
using the Define Positions... option. 
Selecting Edit Positions..., followed 
by one of the four submenu options, 
provides a fast, convenient way to 
rearrange the scan key order and 
alter the appearance and 
functionality of the scanning 
display setup design. 
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Insert ...  _______________________________________________________ (shortcut key: F2) 

The Insert... option is used to insert an 
EMPTY scan key position before any 
chosen position from 1 to 19 in the list. 
If all 20 scan key positions are defined, 
then no more keys can be inserted. Enter 
a number between 1 and 19 in the data 
field and click the OK button to perform 
the insertion operation and close the 
dialog box. Click the Cancel button to 
close the dialog without making an insertion. Suppose 8 scan keys were defined. Inserting a new 
EMPTY position before position #2, then opening the Define Positions dialog box, advancing to 
this position, and editing it would be a quick way to create a new key at the desired position. 
(WinSCAN automatically "closes" the list by removing any EMPTY scan key positions located 
between defined scan key positions when the setup is run.) 

Move ...  _______________________________________________________ (shortcut key: F3) 

The Move... option is used to shift a scan 
key position from one position to 
another in the list. Moving a scan key 
down shifts scan keys above the 
destination location upwards and inserts 
the key definition being moved at the 
desired location. Moving up shifts scan 
keys below the destination location 
downwards. Enter the current location 
number (1 to 20) of the scan key to be moved in the first data field. Enter the destination location 
number (1 to 20) in the second data field. Click the OK button to perform the move operation 
and close the dialog box or click the Cancel button to close the dialog without making a move. 

Switch ...  ______________________________________________________ (shortcut key: F4) 

The Switch... option is used to swap the 
positions of any two scan keys in the list. 
Only the two designated keys are 
affected by the switch operation. Enter 
(in either order) the current location 
number (1 to 20) of one scan key to be 
switched in the first data field and the 
location number (1 to 20) of the other 
scan key to be switched in the second 
data field. Click the OK button to perform the switch operation and close the dialog box or click 
the Cancel button to close the dialog without making a switch.  
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Delete ...  _______________________________________________________ (shortcut key: F5) 

The Delete option is used to remove a 
designated scan key definition and to 
"close" the list by shifting downward all 
remaining scan key definitions above 
the position of the key being deleted. An 
EMPTY scan position is shifted in 
automatically at position #20. Enter the 
current location number (1 to 20) of the 
scan key to be deleted in the data field. 

Click the OK button to perform the delete operation and close the dialog box. Click the Cancel 
button to close the dialog without making a deletion. 

Define Positions ...  __________________________________________ (shortcut key: Ctrl+D) 
The Define Positions... option provides access to each of the 20 scan key positions that form 
WinSCAN setups and scanning displays. The properties associated with each of these positions 
are set using the Define Position # dialog box illustrated on the next page. This dialog box 
assigns a specific mouse function, key function, or special function to each scan position in a 
WinSCAN scanning display. In addition, this is where picture icons (that appear as the scan keys 
in the Picture Window mode) and descriptive words or phrases (that appear as the scan keys in 
the Word Window mode) are associated with each scan key position. 

The "#" in the Define Scan Position title bar and in the Position frame (near the upper left corner 
of the dialog box) indicates the position number of the scan key being edited. This number 
corresponds to a position in the scan key list displayed in the Setup Window. Initially, this 
number will be "1" as shown in the illustration. Clicking on the Prev. or Next button in the 
Position frame scrolls through the list from one scan position to the next, wrapping at each end 
from position 1 to 20 and vice versa. The current setting data for each scan position appears in 
the dialog box. 
An alternate, much quicker way to edit any scan key position is to click on any field in that 
position row in the scan key Position Information datagrid in the Setup Window. For instance, 
clicking in Row #2 inside the datagrid will open immediately the Define Position # dialog box 
showing the current information for Position #2. 
The Define Scan Key dialog box can be tricky to use at first. The parameters for a new key need 
to be defined in a certain order. First, choose the scan key function – e.g., a mouse function, a 
single or combination keyboard function, or a special function such as Control Panel or Text 
Plus or Text Only. Associated with each function is a standard Picture Icon and a standard Scan 
Word or phrase. Second, edit these defaults if desired, picture number first and/or word or phrase 
next. (There is also a non-editable data field called Function. This field is for information 
purposes only and is filled in automatically by WinSCAN.) Third, click the Save Position button 
to record the new scan key definition and update the Setup Window listing or click Save & Adv 
to save this position information and advance to the next position in the sequence. Completing 
the tutorials in earlier sections of this User's Guide is a good way to become familiar with the 
definition process. 
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Mouse functions, including the Left Drag special function, are assigned to scan key positions 
simply by clicking on the appropriate radio button in the Mouse Functions group. (The TAB, 
SPACE BAR, and ENTER keys also work normally to move to and select Define Position # 
dialog box options.) Similarly, the Text Plus or Text Only special function is assigned to a scan 
key by selecting the Text + or Text button in the Keyboard Functions group. Assigning single 
keystrokes (letters, function keys, etc.) or key combinations (Shift+A, Ctrl+F4, Alt+Q, etc.) is 
only slightly more complicated. 

Single keystrokes are assigned to 
scan keys using the Key Stroke 
button. When this button is clicked, 
a prompt message (similar to the 

box above) will appear in the middle of the screen. At this point, press the appropriate keyboard 
key to make the assignment. 

Combination key commands are defined by clicking the Combination Key button. Two 
message prompts follow. The first prompt asks the user to press the first keystroke in the 
combination (e.g., SHIFT, ALT, CTRL). A second prompt then appears, asking the user to 
press the second keystroke in the series (e.g., A, Q, F1, etc.). Only two-key combinations can be 
defined. Be particularly careful to press only one key at a time and check the Function box to be 
sure the result appears to be correct before proceeding further. If a mistake is made, simply click 
the Clear Settings button and try again. This button is a quick way to clear all settings at once 
and create an EMPTY scan key position for subsequent editing. 
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There is always a standard picture icon associated with each mouse function or keyboard key and 
its number is placed automatically in the Picture Choice text field, overwriting the previous 
selection. Picture icon numbers are the numbers that appear beneath the icons in the Picture 
Choices window. The default picture icon is #38. If the Mouse Right radio button in the Mouse 
Functions group is selected, the number in the Picture Choice text field changes to #2, the 
default Mouse Right icon for the Mouse Right function. At this point, the icon can be changed by 
typing any number from 1 to 90 in this text field. 

There is also a standard word or phrase associated with each mouse function or keyboard key. 
This word or phrase is placed automatically in the Scan Word text fields each time the function 
or keystroke associated with the scan position is changed, overwriting whatever was in these text 
fields previously. For example, if the Mouse Right radio button in the Mouse Functions group is 
selected, the top and bottom Scan Word text fields change from EMPTY to Mouse Right. At this 
point, either word can be changed to any other word (max=6 letters) by selecting and editing 
either of the text fields. 

WinSCAN keeps track of any changes in the 
definition of a scan key position. Whenever any 
scan key definition setting is changed, clicking the 
Save Position button records the new scan key 
definition and updates the Setup Window listing. 
Forgetting to click the Save Position or the Save 
& Adv button before closing the dialog box (by 
clicking on the Done button) or before attempting 
to move to the Next or Prev position, produces a 

warning prompt, (shown above) asking whether or not the changes should be saved before 
preceding. (Other warning prompts appear or beeps sound if too many letters are entered in the 
Scan Word text fields [max=6] or if a number < 1 or > 90 is entered in the Picture Choice data 
field.) 

Once all changes have been made and saved, click the Done button to close the dialog box and 
return to the Setup Window. 

The HELP Menu 

The View Help and About WinSCAN options under the 
Help menu open and display this User's Guide and a 
WinSCAN Version and Credits dialog box. This User's 
Guide is distributed as a PDF file and requires Adobe 
Acrobat or Adobe Reader or some other similar program 
that will open and display files of filetype .pdf. Almost 

all recent computers come with software installed to open .pdf files. If not, we recommend 
downloading and installing the free Adobe Acrobat Reader software. These programs will also 
print PDF files (in double-sided page formats on suitable printers) if you need hard copy 
documentation. Use Alt-H as a keyboard shortcut. 
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The CONTROL PANEL Special Function Scanning Display 

The Control Panel special function is an important feature for advanced users that can be 
assigned to a scan key by clicking on the Control Window button in the Define Position # 
dialog box. When the single-switch user selects the Control Panel scan key, the main Scanning 
Window hides and the Control Panel window opens in the same location. 

The Control Panel window provides a 
scanning menu for choosing and changing 
WinSCAN settings dynamically. While 
the Control Panel window is open, the 
scanning selector moves along from one 
option to the next. The current setting for 
each option is shown. To change the Scan 
Speed, for example, the user waits until 
the scanning selector highlights that 
option before pressing the external switch. 
The selector then moves horizontally 
through the list of setting choices (e.g., .5, 
.75, 1, … 2, ... 10 seconds). If the user 
presses the switch when "2" is 
highlighted, the new setting goes into 
effect immediately and remains in effect 
until changed again or until the main 
scanning window is closed. The original 
setup stored on disk is unchanged. 

The two most important uses for the 
Control Settings window are changing the 
DRAG MODE when necessary and 
switching among associated setup files as the user moves from one Windows application to 
another. To switch setups, the user selects the Change to Setup: option, followed by one of the 
associated setup files in the list. This option is the only one that does not take effect immediately. 
The user can reverse a decision to switch setups by choosing Change to Setup: again and 
selecting None. Otherwise, WinSCAN will switch automatically to the new setup when the user 
selects the Quit option and closes the Control Settings window. 

Another useful Control Panel feature is a "precision" mouse cursor movement mode. If the 
current Mouse Jump settings are unable to reach a specific target point on the PC screen, the user 
can open the Control Panel and change the horizontal and/or vertical Jump distance to one pixel. 
After Quitting and subsequently moving the cursor exactly where it should be, the user can 
return to the Control Panel and reset the Mouse Jump distances for faster mouse travel. 
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The DRAG Special Function 
Scanning Display  ___________________________________________________   

When the Left Drag mouse function is assigned to a scan key and included in the scanning 
display setup, the single-switch user has access to a powerful built-in Drag capability. When this 
scan key is selected, a special Drag Window scanning display pops-up and replaces the normal 
WinSCAN display on the screen. Pop-up displays always match the format of the normal 
display. If the normal display uses words rather than icons for scan keys and is oriented 
vertically, then so will be the Drag Window, as shown in one of the examples below. Like other 
WinSCAN pop-up windows, the Drag Window always appears positioned so that its upper left 
corner is located in the same screen position as the window it temporarily replaces. 

The Increment Drag Mode 

WinSCAN features two distinctly different Drag Modes. Dragging with WinSCAN 
in the increment drag mode is really a series of drag and drop operations, not a 
single continuous drag operation. Each time the switch is pressed and released 
when a Drag Left, Right, Up, or Down icon is selected in the Drag Window, the 
effect is equivalent to clicking and holding the mouse button down; moving the 
mouse the preset "mouse jump" number of pixels left or right or up or down; and 
releasing the mouse button. If the switch is held down, this effect repeats at the 
current rate until the switch is released. If the cursor is not positioned over a 
draggable object, only the cursor moves. If the cursor is over a draggable object 
such as a window (or whenever it reaches one), that object is picked up, moved a 
bit, and dropped. Some practice is needed to become accustomed to this effect. 

 

Note that this mode of operation is limited. It is suitable for resizing and 
repositioning windows, rearranging desktop icons, limited control of painting tools, 
and other similar purposes. The increment Drag Mode does not work in some 
windows where there is an underlying "invisible" snap-to grid for objects being 

dragged or where objects must be dragged variable distances before they can be dropped safely. 
One example of such windows include the Microsoft Solitaire card game. Another example is 
Microsoft Office where some features involving dragging in applications such as Excel do not 
work well with this dragging method. 
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The Selection Drag Mode 

Dragging with WinSCAN in the selection drag mode is a single drag and drop operation. As a 
first step, before selecting the Drag scan key, the user positions the mouse cursor over the object 
to be dragged (or precisely at the point where the drag operation is to start) using the mouse 
movement scan keys. Then the user selects the Drag scan key and opens the Drag Window in 
Selection mode. Using the directional drag scan keys in the Drag Window, the user can draw a 
selection rectangle around one or more objects. The last step in this selection sequence is 
choosing the Drag Stop scan key. This closes the Drag Window leaving the object or group of 
objects selected and having the focus. The next step is to open the Drag Window again and use 
the directional drag keys to reposition the object or entire set of objects that have been selected. 

Selection dragging works very much like dragging with the mouse, but unfortunately it does not 
provide many of the visual clues. It is not subject to the limitations of the increment mode and 
works in almost all situations where selection and dragging is required. In particular it works in 
situations where a drag-like operation is used to control a variable size selection rectangle or 
painting tool. This problem is software-specific. For example, selection dragging will place a 
selection rectangle around multiple objects on the Windows Desktop. But it may not work well 
to control the paint tools or the selection marque in Adobe Photoshop. On the other hand, these 
and other functions work as expected in Microsoft Paint.29 In general, experimentation will be 
required and success in every instance is not guaranteed. 

Precision Dragging Operations: Selecting the Trim scan key in the Drag Window 
toggles the "Big Jump" (BJ) / "Little Jump" (LJ) mode for precise dragging 
operations. In the Big Jump mode, the directional drag scan keys move the cursor the 
preset "mouse jump" distance right, left, up, and down. 

In the "Little Jump" mode, these keys move the cursor one pixel at a time. The Drag Window 
title bar display indicates the current jump style and mode for dragging operations. 

It is always a good idea to make sure, especially when using selection drag, that the Desktop or 
the application program window you are working with has the focus. Also remember that 
whatever the selection rectangle touches (as well as whatever is inside) is what will be selected 
and then moved after stopping and restarting the Drag operation and window. 

  

                                                
29  For example, when working in Microsoft Paint, you would use the mouse functions to move to and click on controls 

such as the Paintbrush or Pen. Then move to the drawing window, position the brush or pen cursor, and use Selection 
Drag scan keys to draw, then use Drag Stop. Move the cursor to the Selection control and click to choose it. Move 
back to the drawing window. Reposition the selection cursor and use Selection Drag to draw a selection rectangle 
including that part of the drawing area to be moved. Close and reopen the Selection Drag window and 
drag/reposition the part of the drawing that you selected. Close the Drag window and continue work on your 
drawing. 
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The TEXT WINDOW Special  
Function Scanning Displays  

When one of the two special Text functions is assigned to a scan 
key and included in the scanning control display setup, the 
single-switch user has access to almost the entire keyboard or to 
a full alphabet for quick entries. When a Text scan key is 
selected, a special Text Window scanning display opens, 
replacing the normal scanning display on the screen. A Text Window display always uses letter 
abbreviations rather than graphic icons as scan keys, but otherwise matches the format of the 
normal display. If the normal display is oriented horizontally, then so will be the Text Window. 
In this orientation, a row/column scanning pattern is employed. When the display is oriented 
vertically, the scanning pattern is column/row. Like other WinSCAN pop-up windows, a Text 
Window always appears positioned so that its upper left corner is located in the same screen 
position as the normal window it temporarily replaces. 

The Text Plus Text Window 
The Text Plus Window (shown below) is one of the most powerful special features of WinSCAN. 
By itself, it provides mouse cursor control; clicks and double-clicks; dragging functions; 
keystroke functions such as ENTER, BACKSPACE, and DELETE; full upper and lower case 
text entry; function keys such as F1 to F12; and combination key commands such as Alt+Q or 
Ctrl+F4. The letter scan keys from a to z enter lower case text. Selecting the Shf function causes 
the next letter key selected to be entered as upper case text. Selecting the Cap function toggles 
the keyboard CAPS LOCK ON and OFF, thus providing a way to enter text in all uppercase. 
Selecting the Fnc key followed by a number key from 1 to 9 sends a function key command. 
Selecting the Ctl or Alt key followed by almost any key sends a combination key command.30 
When entering text, mistakes can be corrected using the Del or Bsp functions, just as these would 
be used from the keyboard. The Arrow Key functions (La, Ra, Ua, Da) operate normally to 
reposition the text cursor. The Ins function toggles the Insert or Overstrike mode for text entry. 
In general, all Text Window functions work exactly the way their corresponding keyboard 
equivalents do in the same situations for the software (e.g. a dialog box, word processor, 
e-reader, or browser, etc.) running in the foreground. 

  

                                                
30 The Text Plus Window title bar changes to indicate one of these combo-keys has been pressed. To send the Alt 

keypress by itself, requires the user to select the Alt scan key twice (Alt+Alt = Alt Key). To change the focus from, 
for instance, the scanning window to an application window, send the Alt+Esc combination key. To send a right-
click or right-double click, use Shf+Lc or Shf+Ldc. Combination keys do not repeat. 

 

Text Only 

 

Text Plus 
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Two switch activations are needed to select a particular function in a Text Window: the first to 
choose the row or column containing the function; the second to choose the function itself. 
Holding the switch closed after the second activation causes single key functions to repeat at the 
preset repeat rate. Releasing the switch after the second 
activation resets the scanning selector to the beginning 
of the scan sequence. 

To close a Text Window, press the external switch once 
when the row or column selector reaches the row or 
column containing the Quit scan key. Press the switch 
again as the scan moves into that row and column and 
highlights the Quit key by itself. 
Pressing the ESCAPE key from the keyboard or 
selecting an ESC scan key when any WinSCAN window 
has the focus in general will close that window. Closing 
the main scanning display evokes the Setup Window. 
Closing either the Drag or Text Window reopens the main 
scanning display window. 
The Text Only Text Window 

The Text Only Window (shown at right and below) is designed for text 
entry only, providing speed and simplicity in exchange for versatility. 
Many games and educational programs require only limited text entry 
- a child's name, for instance, to begin play; a multiple-choice entry; or 
simple spelling completion. In other situations, a teacher may wish to 
restrict a child's access to advanced functions and the ability to exit 
from an application program and/or access to the computer's desktop. 
Adult users may find the Text Only Window especially useful in setups 
designed for Internet browsing, text messaging, and email, particularly 
if the few other special commands (e.g., the ENTER key) or symbols 
that are needed frequently are represented by other scan keys in the 
main scanning display. It may be advantageous to include both special 
Text function scan keys in certain setup designs.31 

 
  

                                                
31 The Text Only and main Scanning Windows differ in one important respect from the Text Plus Window. Both of the 

former send “single keypresses” to the application with the focus. The Text Plus Window in contrast sends “text 
strings” in a Unicode format that includes upper and lower case letters and symbols. Both work fine for almost all 
situations where you will need to enter text. However, keypresses will appear only as lowercase letters and 
occasionally a program will not accept a “text string” as a keyboard command, but will require a “keypress” instead. 
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Text Only Window functions include the complete lowercase alphabet scanned in alphabetical 
order; the number keys; the backspace key (for error correction), space bar, several special 
symbols; and Quit to close the window and return to the main scanning display. The behavior of 
this window and its scanning display is identical to that of the Text Plus Window described on the 
previous page. However, the Text Only Window takes up much less visual space on the display 
screen than does the larger text window. Also, the experienced user can generate text at a much 
faster rate of speed using the smaller window since it includes fewer scan keys. 
 

The WinSCAN Scanning Display Window 

The WinSCAN scanning display window opens when the Run option is selected from the Setup 
Window's File menu or the Ctrl+R shortcut key is pressed. The display style (words or icons), 
scanning mode (linear or row/column), design and orientation (vertical or horizontal), initial 
placement position, etc., are determined by the current General Settings. The scanning display 
window can be repositioned on the screen using the mouse. It can not be resized or minimized 
and normally can not be covered by another window. The size of the window is determined by 
the number of scan key positions defined in the setup. This can range from a single row or 
column containing one to twenty keys up to multiple rows or columns containing several keys 
each. The scanning selector is a rectangular box (color = Scan Box Color) that moves linearly 
from one scan key to the next or by row/column or column/row at the preset scan rate. 

Pressing the external switch causes WinSCAN to send the mouse or keystroke message 
associated with the currently selected scan key to the operating system. From there the message 
goes to the application program that has the focus. Holding the switch closed causes the message 
to be sent repeatedly at the preset repeat delay rate. If the selected scan key is one of the special 
function icons (for the control panel, dragging, or text entry), the normal scanning display 
window disappears and a special function display opens at the same point on the screen 

The WinSCAN display window can be closed only when it has the focus - e.g., when it has just 
been clicked on and selected. Then, pressing the ESCAPE key (or selecting the ESC scan key) 
closes the display window and reopens the Setup Window. (There is no System Menu box to 
prevent inadvertent closure.) 

 

 

  

  __________________ (shortcut key: Ctrl+R) 
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WinSCAN Shortcut Key Quick Reference 

Main Setup Window and File Menu: 
Alt+F ..................... Open the Setup Window: File menu 
Alt+S ..................... Open the Setup Window: Settings menu (Press S again to open the Scan Options 

submenu) 
Alt+K ..................... Open the Setup Window: Scan Keys menu 
Ctrl+R ................... Close the Setup and Picture Choices Windows and run the current setup as a 

WinSCAN scanning display 
ESCAPE ................ Close the WinSCAN scanning display window when that window has the focus and 

return to the Setup Window. 

Ctrl+N ................... Open a new Untitled WinSCAN setup. 
Ctrl+O ................... Open the Windows File Open dialog box to load a previously saved WinSCAN setup 
Ctrl+S .................... Save the current WinSCAN setup under the current name immediately, overwriting 

the previous version of the file or open the Windows File Save As dialog box if the 
setup has not been saved previously 

Ctrl+P ................... Open the Windows Print dialog box to send the current WinSCAN setup information 
to the printer as a report 

Ctrl+Q ................... Close the Setup Window and terminate WinSCAN 
Settings Menu: 
Ctrl+W .................. Toggle the current scanning display window style setting from Word Window to 

Picture Window and vice versa 
Ctrl+I .................... Toggle the current Drag style from Increment to Selection and vice versa 
Alt+S, T ................. Open the Tone submenu 
Alt+S, S ................. Open the Scan Options submenu 
Ctrl+Shift+R ......... Open the Scan Options submenu Scan Speed dialog box 
Ctrl+Shift+D ......... Open the Scan Options submenu Scan Design dialog box 
Ctrl+A ................... Open the Autostart dialog box 
Ctrl+J .................... Open the Mouse Jump dialog box 
Scan Keys Menu: 
Ctrl+V or Ctrl+L . Toggle the Picture Choices Window open or closed 
Ctrl+E ................... Open the Edit Positions submenu 

F2 .................... Open the Edit submenu Insert Position dialog box 
F3 .................... Open the Edit submenu Move Position dialog box 
F4 .................... Open the Edit submenu Switch Position dialog box 
F5 .................... Open the Edit submenu Delete Position dialog box 

Ctrl+D ................... Open the Define Positions dialog box. 

Help Menu: 
Ctrl+H ................... Get HELP by opening this User's Guide PDF file 

All WinSCAN windows and dialog boxes operate normally from the keyboard following standard Windows User 
Interface procedures. For example, the ALT key selects the first menu in the active window. The ARROW keys 
move between menus and up and down menu lists. The ENTER key activates the selected menu option. In dialog 
boxes, the TAB key moves the selector from one button or data field to another. The ARROW keys move the 
selector from one radio button, check box, or item within a frame group or a list. The ENTER key activates or 
toggles a selected button, accepts an entry typed in a data field, and so forth. 
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Technical Information and Trouble-Shooting 
This section provides technical information to help solve various hardware problems that may 
arise and usage notes covering many small points not mentioned elsewhere in this User's Guide. 
For further information available after this guide was printed, be sure to check the readme.txt 
file on the WinSCAN distribution flashdrive or the copy of this file placed by the Installer in the 
WinSCAN directory on your hard disk. 

I) WinSCAN reports that SS-ACCESS is "Off-Line": 

EE Problems using the SS-ACCESS USB Adapter: The most likely reason is that the adapter 
is not plugged (directly or through a hub) into one of the computer’s USB ports – or that 
the port it is plugged into does not provide power. Check this first. Note that at present, 
WinSCAN works only with the SS-ACCESS USB Adapter (and with a keyboard hotkey). 
Other switch interfaces or alternate keyboards are not supported. 

E Multiple versions of WinSCAN can 
not be run simultaneously: This 
means that the single-switch user can 
not use WinSCAN to run WinSCAN 
or to run SS-ACCESS for Windows 
or any other program which also uses 
the SS-ACCESS USB Adapter. 
Attempts to do this produce a 
WARNING message box like similar 
to this.32 

II) Various Installation Issues: 

EE Do I need administrative access? Yes, in some cases you may need to have administrator 
access to install or set a program as a default to open a filetype. Most often though, No. 

E WinSCAN requires the Microsoft .Net 4.5.1 Framework: Windows, since version 7, 
comes equipped with .Net and will update that as needed automatically over the Internet. 
Thus during installation, an Internet connection may be required if your copy of Windows 
needs updating before WinSCAN will install or run. 

E Where is the Windows Start Menu Startup directory? This is a fairly easy question: 

C:\ProgramData\Microsoft\Windows\Start Menu\Programs\StartUp 

Put a shortcut to a startup setup (with AutoStart set ON) in this directory.   

                                                
32  Likewise, you can not connect two SS-ACCESS USB Adapters to your computer at the same time. This may change 

in future updates. 
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E Where is the WinSCAN application install directory? This is not a easy question. The 
"safe" location where ClickOnce applications are stored is deep inside your personal User 
subdirectory and would look something like this: (You would seldom if ever go there.) 
C:\Users\YOURUSERNAME\AppData\Local\Apps\2.0\YALP5KGC.JKB\MD8H33JM.6QR
\wins..tion_ef63692f9b2ccfbf_0003.0000_c415e7e7d461afc7 
But you may go here for application reference shortcuts: 

C:\Users\YOURUSERNAME\AppData\Roaming\Microsoft\Windows\Start Menu\ 
Programs\Academic Software, Inc 

E What is an "application reference" shortcut type? An "application reference" shortcut 
icon points to a ClickOnce application that has been installed using a ClickOnce Installer. 
The WinSCAN Installer places this shortcut in the Windows Start Screen App list and on 
your Desktop. This icon points directly to the WinSCAN CS.exe application wherever it 
was installed. The Installer should also set the WinSCAN CS.exe program as the default 
program to open files of filetype .ws. 

E How to manually set WinSCAN to open the .ws setup filetype? In case the Installer was 
unable to set WinSCAN CS.exe as the default application to open files of filetype .ws or 
you chose not to use the Installer and just copied the executable files directory folder from 
the WinSCAN Software flashdrive onto your hard drive, then you must do this yourself. 
The Windows application reference shortcut icon that the Installer places on your Desktop 
points directly to the WinSCAN CS.exe application wherever it was installed. Otherwise, 
you need to know where you put the WinSCAN program files (for instance, in a directory 
named c:\ASI\WinSCAN on your hard drive). These instructions assume you also created 
a directory for WinSCAN setup files on your hard drive as recommended (e.g., 
c:\WinSCAN) and placed the setup files provided on the WinSCAN Software flashdrive 
in that directory. 
Use Windows File Explorer to find the drive and directory where you put the setup files. 
Right-click on the General.ws file and select the Open With submenu option Choose 
Default Program… Be sure the Use this app for all .ws files checkbox is checked. Then 
choose the More options option. Scroll down the list and choose the Look for another app 
on this PC option. A standard Open With … dialog box is presented for you to choose the 
drive and directory containing the program you want to use. Here, either select the Desktop 
and then the WinSCAN application reference or select the drive and the directory where 
you copied the WinSCAN program files and choose WinSCAN CS.exe. (You could, of 
course, hunt through the directories and subdirectories to actually find the WinSCAN 
application install directory but that is rather tedious.) 
At this point, WinSCAN should be the program that opens .ws files. Double-click on one of 
your setup files and confirm WinSCAN opens and displays that setup's information. 

III) Other Miscellaneous Usage Notes 

E WinSCAN may vary slightly in appearance depending upon the selected resolution, 
available colors, and screen font size for the Windows video display mode. For example, 
the red rectangular scanning selector and the scan keys in any WinSCAN scanning display 
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window may not appear perfectly centered or positioned in the SVGA mode with the 
"Large Font" selected. 

E A potential problem may result when only one function is placed in the main scanning 
display window. In this situation, WinSCAN acts like a standard single-function, single-
switch interface. However, if the Scan Speed happens to be set at .5 seconds and there is 
only one key in the display and the user holds down the external switch, the function can be 
repeated too fast. A slower scan speed and repeat rate is the solution. 

E If the mouse buttons are swapped (using the Windows Control Panel), WinSCAN's mouse 
click functions will continue to behave normally. If a left click normally would be required 
for an action of some sort, the WinSCAN user should choose the Left Click scan key, even 
though the user would have to click the right button on the mouse to get the same effect. 

E There are times when the Windows operating system may suspend all running application 
programs (including WinSCAN) and demand a user response. In these situations, a key 
must be pressed or the mouse clicked. Also if WinSCAN ever "hangs" or becomes unre-
sponsive, like any other application it can be terminated using the Windows Task Manager. 

E To exit Windows using WinSCAN alone, the Right Click scan key must be included in the 
current setup (or in an associated setup file).33  Right-clicking on the Windows Desktop 
Start icon in the Task Bar pops up a list of many useful Windows options accessible using 
the Arrow scan keys. One of these is the Shut Down or Sign Out submenu with options to 
Log Out, Shut Down, or Restart. 

E If there is no mouse plugged into the computer when Windows starts or re-starts or for 
some reason Windows does not detect a mouse, WinSCAN will run a setup that includes 
mouse functions, but these may not work. It will run setups that include keyboard functions 
and the special Text functions. When Text Plus is selected, the Text Plus Window will open 
and run but again the mouse functions may not work. This problem is seldom encountered, 
especially on laptops with built-in touch pads or mouse controls. 

E If the Drag Style setting is Increment, the Drag Window special functions may not work in 
some windows where there is an underlying "invisible" snap-to grid for objects being 
dragged or in windows where objects must be dragged variable distances before they can 
be dropped safely. Try using selection dragging in such situations. 

E WinSCAN is designed to work on the Desktop and does not work well (or at all) with the 
Start Screen or with certain full screen applications from the Windows Store. On the 
other hand, WinSCAN will work in Desktop normal full-screen mode and will also work in 
a split-screen mode where one side displays the Desktop. (In this case, be sure the 
WinSCAN Scanning Display is positioned to the right or the left edge of the Desktop split-
window so that it can be seen.) 

We hope and expect that you will have little or difficulty installing, running, 
and using WinSCAN. Please let us know at asistaff@acsw.com 

how your experience might be improved. 

                                                
33  To send a right-click or right-double click from the Text Plus window, use Shf+Lc or Shf+Ldc. 


